
Ca
de

rn
os

 de
 In

for
m

áti
ca

1

COMPUTAÇÃO GRÁFICA
Secretaria de Estado de Educação MG



Lindsley Daibert
Coordenador

Carlos Eduardo Hermeto Sá Motta



COMPUTAÇÃO GRÁFICA
Secretaria de Estado de Educação MG

4

Ca
de

rn
os

 de
 In

for
m

áti
ca



Ca
de

rn
os

 de
 In

for
m

áti
ca

5

COMPUTAÇÃO GRÁFICA
Secretaria de Estado de Educação MG

Os computadores que estão sendo instalados pela SEE nas escolas estaduais deverão ser
utilizados para propósitos administrativos e pedagógicos. Para isso, desenvolveu-se
um conjunto de cursos destinados a potencializar a utilização desses equipamentos.
São doze cursos que estão sendo disponibilizados para as escolas para enriquecimento
do seu plano curricular. Esses cursos não são profissionalizantes. São cursos
introdutórios, de formação inicial para o trabalho, cujo objetivo é ampliar o horizonte
de conhecimentodos alunos para facilitar a futura escolha de uma profissão.

Todos os cursos foram elaborados para serem realizados em 40 módulos-aula, cada um
deles podendo ser desenvolvidos em um semestre (com 2 módulos-aula semanais) ou
em 10 semanas (com 4 módulos-aula semanais). Em 2006, esses cursos deverão ser
oferecidos para os alunos que desejarem cursá-los, em caráter opcional e horário extra-
turno.

Em 2007, eles cursos deverão ser incluídos na matriz curricular da escola, na série ou
séries por ela definida, integrando a Parte Diversificada do currículo.

Esses cursos foram concebidos para dar aos professores, alunos e funcionários uma
dimensão do modo como o computador influencia, hoje, o nosso modo de vida e os
meios de produção. Para cada curso selecionado pela escola deverão ser indicados pelo
menos dois ou, no máximo, três professores (efetivos, de preferência) para serem capa-
citados pela SEE. Esses professores irão atuar como multiplicadores, ministrando-os a
outros servidores da escola e aos alunos.

CURSO DE CAPACITAÇÃO EM INFORMÁTICA INSTRUMENTAL

Este curso será implantado obrigatoriamente em todas as escolas estaduais em que for
instalado laboratório de informática. Iniciando pelas Escolas-Referência, todos os pro-
fessores e demais servidores serão capacitados para que possam fazer uso adequado e
proveitoso desses equipamentos tanto na administração da escola como nas atividades
didáticas.

É um curso voltado para a desmistificação da tecnologia que está sendo implantada. O
uso do computador ainda é algo difícil para muitas pessoas que ainda não estão muito
familiarizadas com essas novas tecnologias que estão ocupando um espaço cada vez
maior na escola e na vida de todos. Este curso vai motivar os participantes para uma
aproximação com essas tecnologias, favorecendo a transformação dos recursos de
informática em instrumentos de produção e integração entre gestores, professores e
demais servidores. As características dos equipamentos e as funcionalidades dos pro-
gramas serão apresentadas de maneira gradual e num contexto prático. Essas.situações
práticas serão apresentadas de maneira que o participante perceba o seu objetivo e o
valor de incorporá-las ao seu trabalho cotidiano. Os participantes serão preparados

APRESENTAÇÃO
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para navegar e pesquisar na internet; enviar, receber e administrar correspondência
eletrônica, além de criar e editar documentos (textos, planilhas e apresentações) de
interesse acadêmico e profissional. Esse é um curso fundamental, base e pré-requisito
para todos os demais.

CURSO DE MONTAGEM E MANUTENÇÃO DE COMPUTADORES

Este curso será implantado em, pelo menos, uma escola do município sede de cada
Superintendência Regional de Ensino. A indicação da escola deverá ser feita pela pró-
pria S.R.E, levando-se em conta as condições de infra-estrutura nas Escolas-Referência
existentes no município. Nas escolas escolhidas será montado um laboratório de
informática especialmente para a oferta desse curso.

O objetivo deste curso é capacitar tecnicamente os alunos de ensino médio que queiram
aprender a montar, fazer a manutenção e configurar microcomputadores. Pode ser ofe-
recido para alunos de outras escolas, para professores e demais servidores da escola e
para a comunidade, aos finais de semana ou horários em que o laboratório esteja dis-
ponível.

Neste curso o participante aprenderá a função de cada um dos componentes do
microcomputador. Aprenderá como montar um computador e como configurá-lo,  insta-
lando o sistema operacional, particionando e formatando discos rígidos, instalando pla-
cas de fax/modem, rede, vídeo, som e outros dispositivos. Conhecerá, ainda, as técnicas
de avaliação do funcionamento e configuração de microcomputadores que esteja preci-
sando de manutenção preventiva ou corretiva, além de  procedimentos para especificação
de um computador para atender as necessidades requeridas por um cliente.

Dos cursos que se seguem, as Escolas-Referência deverão escolher pelo menos dois para
implantar em 2006.

No período de 13 a 25 de março/2006, estará disponível no sítio da SEE
(www.educacao.mg.gov.br) um formulário eletrônico para que cada diretor das Escolas-
Referência possa informar quais os cursos escolhidos pela sua escola e quais os profes-
sores que deverão ser capacitados. Durante o período de capacitação, os professores
serão substituídos por professores-designados para que as atividades didáticas da es-
cola não sejam prejudicadas.

1. CURSO SOBRE O SISTEMA OPERACIONAL LINUX

É destinado àqueles que desejam conhecer ferramentas padrão do ambiente Unix. É um
curso voltado para a exploração e organização de conteúdo. São ferramentas tipica-
mente usadas por usuários avançados do sistema operacional. Tem por finalidade apre-
sentar alguns dos programas mais simples e comuns do ambiente; mostrar que, mesmo
com um conjunto pequeno de programas, é possível resolver problemas reais; explicar
a comunicação entre programas via rede e estender o ambiente através de novos pro-
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gramas. O texto didático deste curso apresenta os recursos a serem estudados e propõe
exercícios. É um curso para aqueles que gostam de enfrentar desafios.

Ementa: Histórico e desenvolvimento do Unix e Linux. Login no computador. Exploran-
do o computador (processos em execução, conexões abertas). Descrição dos conceitos
de arquivo e diretório. Operações simples sobre arquivos e diretórios. Sistema de per-
missões e quotas.

Procurando arquivos e fazendo backups. Executando e controlando programas.
Processamnto de texto. Expressões regulares. Estendendo o ambiente. Trabalho em
rede. Um sistema de chat. Comunicação segura no chat (criptografia). Ainda criptografia.
Sistema de arquivos como um Banco de Dados. Um programa gráfico. Programando
para rede.

2. CURSO DE PROGRAMAÇÃO EM JAVA

É um curso de programação introdutório que utiliza a linguagem Java. Essa linguagem
se torna, a cada dia, mais popular entre os programadores profissionais. O curso foi
desenvolvido em forma de tutorial. O participante vai construir na prática um aplicativo
completo (um jogo de batalha naval) que utiliza o sistema gráfico e que pode ser utili-
zado em qualquer sistema operacional. Os elementos de programação são apresentados
em atividades práticas à medida em que se fazem necessários. Aqueles que desejam
conhecer os métodos de produção de programas de computadores terão, nesse curso,
uma boa visão do processo.

Ementa: Conceitos de linguagem de programação, edição, compilação, depuração e exe-
cução de programas. Conceitos fundamentais de linguagens de programação orientada
a objetos.

Tipos primitivos da linguagem Java, comandos de atribuição e comandos de repetição.
Conceito de herança e programação dirigida por eventos. Tratamento de eventos. Pro-
gramação da interface gráfica. Arrays. Números aleatórios.

3. CURSO DE INTRODUÇÃO AO BANCOS DE DADOS

Este curso mostrará aos participantes os conceitos fundamentais do armazenamento,
gerenciamento e pesquisa de dados em computadores. Um banco de dados é um
repositório de informações que modelam entidades do mundo real. O Sistema Gerenciador
do Banco de Dados permite introduzir, modificar, remover, selecionar e organizar as
informações armazenadas. O curso mostra como os bancos de dados são criados e
estruturados através de exemplos práticos. Ao final, apresenta os elementos da lingua-
gem SQL (Structured Query Language – Linguagem Estruturada de Pesquisa) que é uma
linguagem universal para gerenciamento de informações de bancos de dados e os ele-
mentos básicos da administração desses repositórios de informação..Apesar de ser de
nível introdutório, o curso apresenta todos os tópicos de interesse relacionados à área.
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É um curso voltado para aqueles que desejam conhecer os sistemas que gerenciam volu-
mes grandes e variados de informações, largamente utilizados no mundo empresarial.

Ementa: Modelagem de dados. Normalização. Linguagem SQL. Mecanismos de consulta.
Criação e alteração de tabelas. Manipulação e formatação de dados. Organização de
resultados de pesquisa. Acesso ao servidor de bancos de dados. Contas de usuários.
Segurança. Administração de bancos de dados. Manutenção. Integridade.

4. CURSO DE CONSTRUÇÃO DE WEB SITES

Este curso mostrará aos participantes como construir páginas HTML que forma a estru-
tura de um “site” na internet. A primeira parte do curso é voltada para a construção de
páginas; a segunda parte, para a estruturação do conjunto de páginas que formação o
“site”, incluindo elementos de programação. Explicará os conceitos elementares da web
e mostrará como é que se implementa o conjunto de páginas que forma o “site” num
servidor.

Ementa: Linguagem HTML. Apresentação dos principais navegadors disponíveis no mer-
cado.

Construção de uma página HTML simples respeitando os padrões W3C. Recursos de
formatação de texto. Recursos de listas, multimídia e navegação. Tabelas e Frames.
Folha de Estilo. Elementos de Formulário. Linguagem Javascript. Interação do Javascript
com os elementos HTML. Linguagem PHP. Conceitos de Transmissão de Site e critérios
para avaliação de servidores.

1. CURSO DE EDITORAÇÃO ELETRÔNICA

Voltado para a produção de documentos físicos (livros, jornais, revistas) e eletrônicos.
Apresenta as ferramentas de produção de texto e as ferramentas de montagem de ele-
mentos gráficos numa página. O texto é tratado como elemento de composição gráfica,
juntamente com a pintura digital, o desenho digital e outros elementos gráficos utiliza-
dos para promover a integração dos elementos gráficos.

O curso explora de maneira extensiva os conceitos relacionados à aparência do texto
relativos aos tipos de impressão (fontes). Mostra diversos mecanismos de produção
dos mais variados tipos de material impresso, de texto comum às fórmulas matemáti-
cas. Finalmente, discute a metodologia de gerenciamento de documentos.

Ementa: Editor de textos. Formatadores de texto. Tipos e Fontes. Gerenciamento de
projetos.

Publicações. Programas para editoração. Programas acessórios. Impressão. Desenvolvi-
mento de um projeto.
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2. CURSO DE ILUSTRAÇÃO DIGITAL

Desenvolvido sobre um único aplicativo de tratamento de imagens e pintura digital, o
GIMP (GNU Image Manipulation Program – Programa de Manipulação de Imagens GNU).

Este curso ensina, passo a passo, como utilizar ferramentas do programa para produzir
ilustrações de qualidade que podem ser utilizadas para qualquer finalidade. A pintura
digital é diferente do desenho digital. O desenho se aplica a diagramas e gráficos, por
exemplo. A pintura tem um escopo muito mais abrangente e é uma forma de criação
mais livre, do ponto de vista formal. É basicamente a diferença que há entre o desenho
artístico e o desenho técnico. É, portanto, um curso voltado para aqueles que têm inte-
resses e vocações artísticas.

Ementa: A imagem digital. Espaços de cores. Digitalização de imagens. Fotomontagem e
colagem digital. Ferramentas de desenho. Ferramentas de pintura. Finalização e saída.

3. CURSO DE PRODUÇÃO FONOGRÁFICA

Curso voltado para aqueles que têm interesse na produção musical. Explica, através de
programas, como é que se capturam, modificam e agrupam os sons musicais para pro-
duzir arranjos musicais. É um curso introdutório com uma boa visão da totalidade dos
procedimentos que levam à produção de um disco.

Ementa: O Fenômeno Sonoro. O Ambiente Sonoro. A Linguagem Musical. Pré-Produção.
O Padrão MIDI. A Gravação. A Edição. Pós-processamento. Mixagem. Finalização.

4. CURSO DE COMPUTAÇÃO GRÁFICA

Curso introdutório de modelagem, renderização e animação de objetos tridimensionais.

Esse curso é a base para utilização de animações tridimensionais em filmes. Conduzido
como um tutorial do programa BLENDER, apresenta a interface do programa e suas
operações elementares. Destinado àqueles que têm ambições de produzir animações de
alta qualidade para a educação ou para a mídia.

Ementa: Introdução à Computação Gráfica. Conceitos básicos 2D e 3D. Interface princi-
pal do programa Blender. Espaço de trabalho. Navegação em 3D. Modelagem em 3D.
Primitivas básicas. Movimentação de objetos. Edição de objetos. Composição de cenas.
Materiais e texturas. Aplicação de materiais. UV Mapping. Luzes e Câmeras. Iluminação
de cena. Posicionamento e manipulação de câmera. Renderização still frame. Formatos
de saída. Animação básica. Movimentação de câmera e objetos. Renderização da anima-
ção. Formatos de saída.
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5. CURSO DE PROJETO AUXILIADO POR COMPUTADOR

Os programas de CAD (Computer Aided Design – Projeto Auxiliado por Computador) são
utilizados para composição de desenhos técnicos. Diferentemente dos programas de
pintura eletrônica (como o GIMP), fornecem ao usuário ferramentas para desenhar com
precisão e anotar os desenhos de acordo com as normas técnicas. Além de ensinar ao
usuário a utilizar um programa de CAD (QCad), o curso apresenta elementos básicos de
desenho técnico e construções geométricas diversas visando preparar o participante
para um aprimoramento em áreas típicas das engenharias e da arquitetura..Ementa:
Informática aplicada ao desenho técnico. Conceitos básicos: construções geométricas,
escalas, dimensionamento, projeções ortográficas e perspectivas. Sistemas de coorde-
nadas cartesiano e polar. Novas entidades geométricas básicas: polígonos e círculos.

Operações geométricas básicas. Tipos de unidades de medida. Criação de um padrão de

formato. Organização de um desenho por níveis. Construções geométricas diversas. A
teoria dos conjuntos aplicada ao desenho. Propriedades dos objetos. Edição do dese-
nho.

Movimento, rotação, escalamento e deformação de objetos. Agrupamento de objetos
em  blocos.

6. CURSO DE MULTIMÍDIA NA EDUCAÇÃO

O curso está dividido em três partes: a) utilização da multimídia no contexto educacio-
nal;

b) autoria de apresentações multimídia; c) projetos de aprendizagem mediada por
tecnologia. Este curso é o fundamento para a criação dos cursos de educação a distân-
cia.

Apresenta os elementos que compõem os sistemas de multimídia, as comunidades vir-
tuais de aprendizagem, o planejamento e a preparação de uma apresentação e de uma
lição de curso e, finalmente, a tecnologia de objetos de aprendizado multimídia.

Ementa: Introdução à Multimídia e seus componentes. Multimídia na Educação. Comu-
nidades Virtuais de Aprendizagem. “Webquest”: Desafios Investigativos baseados na
Internet (Web).

Preparação uma apresentação multimídia.
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INTRODUÇÃO

A ELABORAÇÃO DE UMA ANIMAÇÃO FEITA POR COMPUTADOR PASSA POR UMA SÉRIE DE ETAPAS, E CADA UMA
DELAS VAI ADICIONANDO COMPLEXIDADE AO QUE ESTÁ SENDO CONSTRUÍDO ATÉ QUE O PRODUTO FINAL SEJA
ALCANÇADO O PRODUTO FINAL SEJA ALCANÇADO.

MODELAGEM

A modelagem é o primeiro passo em uma animação. É através dela que construímos os
objetos virtuais que farão parte da cena. Existem várias ferramentas disponíveis para a
criação de formas geométricas básicas e para sua edição, ou modificação. Essas
modificações podem ser na forma ou na posição dos objetos.

MATERIAIS

Para um que um objeto tenha a semelhança com o que se imagina, podemos determinar
as cores e características de sua aparência, com grande similitude. É possível se controlar
o brilho, a transparência, a auto-emissão de luz e a repetição de padrões. Qualquer
imagem gerada por fotografia digital, scanner ou software pode ser projetada na su-
perfície de um objeto virtual, fazendo-o se parecer com o original.

ILUMINAÇÃO

Por mais que a cena criada possua detalhes, cores e texturas interessantes, nada disto
será visto com clareza se não houver uma boa iluminação. Ela é utilizada para se criar
um clima específico, ressaltar determinadas partes da cena ou melhorar o realismo da
situação apresentada. Para isto podemos controlar o tipo de luz, a cor, a intensidade e
a sua posição.

CÂMERA

A câmera fotográfica virtual determina o ponto de vista do espectador. Ela se movimenta
e acompanha movimentos enquadrando a cena que queremos que seja vista. Podemos
escolher o tipo de lente utilizada, conseguindo efeitos óticos semelhantes aos
conseguidos com câmeras reais.

RENDERIZAÇÃO

A renderização é a etapa final de uma animação, onde o computador calcula a imagem
de cada cena em todos os seus detalhes. Quanto mais realista for a cena, mais tempo
leva o computador para renderizá-la. O resultado final é um arquivo de animação ou
uma série de arquivos de imagens fixas, que tem que ser montados posteriormente em
uma animação contínua.

Ao final deste curso, você deverá estar apto a realizar uma animação 3D simples no
computador, seguindo as etapas descritas. A seguir serão apresentados mais detalhes
sobre cada uma destas etapas, realizadas no programa Blender, para Linux.
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MÓDULO 1:
INTRODUÇÃO À COMPUTAÇÃO GRÁFICA. CONCEITOS BÁSICOS 2D E 3D. INTERFACE PRINCIPAL DO
BLENDER.  ESPAÇO DE TRABALHO.  RECONFIGURANDO A INTERFACE.  GRAVANDO UMA CENA. CARRE-
GANDO UMA CENA.  VISUALIZAÇÃO. NAVEGAÇÃO EM 3D.

1.1 INTRODUÇÃO À COMPUTAÇÃO GRÁFICA.

Os objetos que são criados virtualmente em um computador não existem fisicamente.
São representações numéricas armazenadas em sua memória, transformadas através de
operações matemáticas e projetadas no monitor em uma forma reconhecível. Essas
operações matemáticas são invisíveis para o usuário, que trabalha apenas em níveis
mais elevados de representação, manipulando ícones e botões para conseguir o resultado
visual desejado.

Vivemos em um mundo tridimensional. Isto significa que são necessárias três coordenadas
para se definir a localização de um ponto no espaço. Os objetos que nos cercam também
tem sua forma caracterizada a partir de três dimensões: altura, largura e profundidade.
Entretanto, o termo computação gráfica tridimensional não corresponde totalmente à
realidade. No computador nós manipulamos uma representação bidimensional de um
mundo virtual tridimensional, pois o monitor do computador só tem capacidade para
mostrar duas dimensões: a altura e a largura. O que nos dá a ilusão de que a imagem que
estamos vendo tem volume são as luzes, cores e sombras que simulam a profundidade
da cena, ainda que sua representação seja em 2D. Pense na televisão: as cenas que se
sucedem, vívidas e coloridas, nos dão a sensação quase palpável de uma realidade
tridimensional, mas a tela da TV é plana, contando apenas com duas dimensões.

1.2 CONCEITOS BÁSICOS 2D E 3D.

Ao lidarmos com imagens num computador, utilizamos referências chamadas de
coordenadas espaciais, representadas por números pertencentes a eixos de referência.
Quando lidamos com imagens bidimensionais, são utilizados dois eixos: o eixo X
(horizontal) e o eixo Y (vertical).

O espaço tridimensional em que os objetos são criados através do Blender é também um
espaço virtual, existente apenas no software. Esse volume é infinitamente grande, como
o espaço real, o que poderia nos levar a ficar perdidos dentro dele se não pudéssemos
contar com referências espaciais. Como o espaço é tridimensional, logicamente existem
três eixos, chamados de X, Y e Z. Assim, o ponto central de todo esse volume é definido
pelas coordenadas 0,0,0, ou seja, coordenada zero no eixo X (horizontal), coordenada
zero no eixo Y (vertical), e coordenada zero no eixo Z (eixo perpendicular à tela do

computador). Esse ponto é chamado de ponto de origem,
e está localizado na interseção dos eixos X, Y, e Z. Para
localizar qualquer ponto nesse espaço, basta fornecer suas
três coordenadas espaciais. Por exemplo: o ponto com as
coordenadas 120, 234, 23 possui coordenada 120 no eixo
horizontal, coordenada 234 no eixo vertical e coordenada
23 no eixo da profundidade (perpendicular à tela do
computador). Números negativos significam que o ponto
está localizado no mesmo eixo, mas no sentido contrário
em relação ao ponto de origem (Figura 1.1).

Fig. 1.1:
Eixos de
referência 3D.
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A geometria nos diz que o mínimo para se definir uma linha reta são dois pontos.
Quando essa reta é desenhada em 2D, necessitamos apenas de duas coordenadas para

definir cada ponto: X e Y. Entretanto, se quisermos desenhar
uma linha reta no espaço precisamos determinar as
coordenadas tridimensionais dos dois pontos que a
definem. Quando construímos um objeto tridimensional,
os pontos extremos que definem as linhas do objeto são
chamados de vértices, as linhas são chamadas de arestas, e
os lados do objeto são chamados de faces (Figura 1.2).

1.3 INTERFACE PRINCIPAL DO BLENDER VERSÃO 2.37 .

O Blender é um programa para criação, edição e animação de cenas tridimensionais. É
um programa sólido e relativamente poderoso, que possui a grande vantagem de ser
gratuito, por ser executado no ambiente Linux. Essa não é uma pequena vantagem,
pois programas similares para o ambiente Windows custam vários milhares de dólares.

Apesar da interface do Blender não seguir um padrão habitual, ela é altamente eficiente
e consistente, permitindo um trabalho rápido, intuitivo e preciso depois de ser dominada.
Uma das regras básicas para se trabalhar com o Blender é utilizar tanto o mouse como
o teclado, que possui diversos atalhos para praticamente todas as funções importantes
do programa. Mesmo que no início seja um pouco difícil se lembrar de tantas
combinações de teclado para acessar essas funções, com o tempo esses atalhos acabarão
sendo memorizados e facilitarão enormemente o desenvolvimento do trabalho. A
interface foi projetada para funcionar com um mouse de três botões, mas se o seu
mouse possuir apenas dois botões, basta apertar a tecla Alt mais o botão esquerdo do
mouse para simular o botão do meio.

1.4 ESPAÇO DE TRABALHO.

Ao abrir o programa Blender, ele se apresenta com uma tela padrão. A tela de trabalho
do Blender se divide em três partes. Na parte superior se encontra a janela de informa-
ções (Info Window). Nesta área são mostradas algumas estatísticas sobre a cena em que
se está trabalhando, o número da versão do programa e algumas outras informações
(Figura 1.3). Ve: informa o número total de vértices dos objetos da cena. Fa: informa o
número de faces de todos os objetos da cena. Ob: mostra dois números. O primeiro é o
número total de objetos na cena. O segundo é o número de objetos selecionados na-
quele momento. Mem: indica a memória utilizada pelo programa.

Na parte inferior encontra-se a janela dos botões (Buttons Window), assim chamada
por razões óbvias. Nesta janela encontram-se diversas opções de edição da cena de
trabalho: luzes, câmeras, materiais, ajustes de renderização e animação, além de outras
(Figura 1.4). Além de cada botão ter seu texto denominativo, ao se posicionar o mouse
sobre o botão, sem apertá-lo, aparece também um rótulo explicativo da sua função. As
funções que podem ser acessadas através de atalhos de teclado tem esses atalhos

Fig. 1.2:
Definições.

Fig. 1.3:
Info Window.
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descritos na frente de cada função. Quando uma letra é precedida de Ctrl, Shift, ou Alt,
essas teclas devem ser mantidas pressionadas enquanto você aperta a tecla com a letra
desejada.

A janela central é a janela 3D (3D Window), onde ocorrerão todos os trabalhos de
criação e edição da sua cena tridimensional (Figura 1.5). O quadriculado cinza representa
uma grade de referência para o alinhamento de objetos no espaço 3D, e é chamado de
plano padrão. O quadrado central é na verdade um cubo alinhado com o plano padrão
que serve como referência espacial. Ele pode ser apagado sem problemas, caso não seja
útil para o seu projeto, teclando Delete e depois clicando a opção Erase Selected?. O
cursor tem a forma de quatro linhas em cruz com um círculo branco e vermelho, e pode
ser posicionado em qualquer lugar do espaço 3D, clicando-se com o botão esquerdo do
mouse. Além de ser usado para criar, selecionar e mover objetos, ele também é utilizado
para marcar o centro de algumas operações, tais como rotação ou escalamento. A pirâmide
preta embaixo representa a câmera e a seta mostra para onde está apontada.

Cada janela possui um cabeçalho (Header) (Figura 1.6). Na janela 3D, esse cabeçalho é
localizado na parte inferior, e pode ter sua localização modificada clicando-se numa
área vazia da barra com o botão direito do mouse e confirmando a opção que se abre –
Top, Bottom, ou No Header (Acima, Abaixo ou Sem cabeçalho). Escolha cada uma des-
sas opções e verifique como o cabeçalho aparece na tela.

Existe um botão especial que fica na parte mais à esquerda de cada janela, que pode
mostrar mais opções clicando-se nele com o botão esquerdo do mouse (Figura 1.7). Ele
mostra vários outros ícones, correspondentes a diferentes tipos de combinações de
botões que irão aparecer na janela selecionada. Quando um desses ícones é acionado,
são modificados os botões da janela escolhida, apresentando outras funções.

Fig. 1.4:
Buttons
Window.

Fig. 1.5:
3D Window.

Fig. 1.6:
Header.
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Experimente clicar em cada uma das opções dos tipos de janela e veja como a configuração
muda totalmente de acordo com o contexto da sua escolha. Não se esqueça de voltar a
janela inferior para a configuração Buttons Window no final, para seguirmos com os
próximos exercícios.

1.5 RECONFIGURANDO A INTERFACE

A janela 3D pode ser reconfigurada de uma série de maneiras. Uma opção possível é
criar mais janelas dividindo-se as já existentes. A partir de agora iremos fazê-lo. Para
isso basta mover o cursor sobre uma linha de contorno da janela e pressionar o botão
do meio ou o botão direito do mouse (Figura 1.8). Aparece uma pequena janela pedin-
do uma confirmação (Split Area), que deve ser dada clicando-se com o botão esquerdo
do mouse. Vai aparecer uma linha representando a divisão da janela, que pode ser

posicionada de acordo com a sua vontade e ter sua localização
confirmada com um clique do botão esquerdo do mouse. As ja-
nelas podem ser divididas horizontal ou verticalmente, depen-
dendo da linha da janela que foi escolhida para ser dividida.
Experimente dividi-las das duas maneiras. As janelas também
podem ser apagadas ou unidas de forma parecida, devendo-se
posicionar o mouse sobre a linha divisória da janela escolhida,
clicando-se com o botão direito do mouse e confirmando a op-

ção Juntar áreas (Join Areas). Existe também a opção No Header, que torna a barra de
cabeçalho invisível.

Se o cabeçalho estiver invisível e quisermos torná-lo novamente visível, é preciso primeiro
clicar na janela desejada para ativá-la, e depois mover o cursor
sobre uma linha de contorno da janela e pressionar o botão do
meio ou o botão direito do mouse. Agora o menu apresenta a
opção Add Header, que retorna com o cabeçalho ao ser clicada
com o botão esquerdo do mouse (Figura 1.9).

Fig. 1.7:
Botão especial
com opções de
reconfiguração
da janela.

Fig. 1.8:
Diálogo para
divisão de
janela.

Fig. 1.9:
Volta do
cabeçalho.
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Quando a janela 3D está dividida, podemos modificar o tamanho das janelas posicionando
o cursor na linha que separa as janelas até que ele mude de forma, e depois clicando e
arrastando com o botão esquerdo do mouse. Experimente modificar o tamanho da jane-
la dessa forma (Figura 1.10).

A vantagem de se trabalhar com mais de uma janela é que podemos visualizar o objeto
criado de vários ângulos diferentes, recurso fundamental para se trabalhar com três
dimensões (Figura 1.11). Geralmente é melhor começar criando os objetos na vista de
topo e utilizar as outras vistas para posicioná-los adequadamente na cena.

Na ilustração acima, a vista esquerda inferior é uma vista de topo (Top), a vista esquer-
da superior é uma vista de lado (Side) e a vista maior é uma vista de usuário (User),

acionada quando giramos livremente o ponto de vista. Estas vistas
podem ser selecionadas no cabeçalho de cada janela, no menu View
(Figura 1.12). As opções disponíveis são Side (Lado), Front (Frente),
Top (Topo), Camera (Câmera) e User (Usuário). A vista Side
corresponde a olhar ao longo do eixo X na direção negativa. A vista
Front ao longo do eixo Y e a vista Top ao longo do eixo Z. Você pode
também acionar estas vistas utilizando o teclado numérico. Veja na
figura 12 como há um número na frente de cada opção: Side – 3,
Front – 1, Top – 7 e Camera – 0. A vista User não possui um atalho,
pois ela é variável e não fixa como as outras. Mais à frente isso ficará
mais claro para você.

Fig. 1.10:
Redimensionamento
de janela.

Fig. 1.11: Três
janelas
mostrando vistas
diferentes.

Fig. 1.12:
Vistas no menu
View.
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Lembre-se de que os atalhos do teclado agem sobre a janela que está “em foco” no
momento. Antes de utilizá-los certifique-se de que a janela em que você quer que a ação
aconteça está em foco, posicionando o cursor sobre ela. Note como a janela em foco faz
o cabeçalho da mesma ter uma coloração cinza ligeiramente mais clara.

1.6 GRAVANDO UMA CENA

Ao criar uma cena no Blender, é necessário gravá-la no disco rígido ou em outro meio
permanente para que possamos recuperá-la depois. Se fecharmos a janela principal do
Blender, o programa se encerrará sem perguntar se você deseja gravar a cena em que
está trabalhando. Se a cena não tiver sido gravada anteriormente, ela será
irremediavelmente perdida. Para salvar uma cena basta clicar F2 para abrir a janela de
diálogo. À esquerda, em cima, o botão P (ou a tecla P) leva para o diretório
hierarquicamente superior, o botão logo abaixo permite escolher o disco desejado.
Clicando-se no espaço à frente de cada botão pode-se escrever o nome do arquivo
desejado. Pode-se também clicar com o botão esquerdo do mouse no arquivo listado e
confirmar a opção. Na extremidade direita, acima, estão os botões Save File, para con-
firmar a gravação, ou Cancel, para cancelar a operação. Outra alternativa é se clicar no
nome do arquivo desejado com o botão do meio do mouse. Isto irá gravar o arquivo
imediatamente, com aquele nome. A extensão .blend será adicionada automaticamente
ao arquivo. Se você preferir apenas atualizar a gravação do arquivo que está sendo
trabalhado, basta teclar Ctrl-W ao invés de F2 e confirmar a opção, pulando o diálogo
de gravação.

Grave a cena em que você está trabalhando da forma como foi descrito para que você
compreenda melhor o processo.

1.7 CARREGANDO UMA CENA

Ao gravar um arquivo no formato .blend, o programa armazena tudo sobre a cena:
objetos, luzes, câmeras, texturas, e até mesmo os ajustes do usuário na interface do
programa. Mas atenção! Quando um novo arquivo é carregado, o Blender não pergunta
se o usuário quer gravar a cena que estava sendo previamente trabalhada. A nova cena
é imediatamente carregada e a anterior será perdida, se não tiver sido gravada. Para
carregar um projeto previamente armazenado, basta clicar F1 para abrir a janela de
diálogo. O resto funciona como descrito no parágrafo anterior. À esquerda, em cima, o
botão P (ou a tecla P) leva para o diretório hierarquicamente superior, já o botão logo
abaixo permite escolher a unidade de disco desejada. Pode-se clicar diretamente no
arquivo escolhido na lista (com o botão esquerdo do mouse e confirmar) ou escrever o
nome do arquivo a ser carregado no espaço à frente de cada botão. Na extremidade
direita estão os botões Open File, para confirmar o carregamento, ou Cancel, para can-
celar a operação. Outra alternativa é se clicar no nome do arquivo desejado com o botão
do meio do mouse. Isto irá carregar o arquivo imediatamente.

Para se exercitar, carregue o arquivo tresjanelas.blend para ver a cena da figura A11.
Clique em File>Open. Na janela de diálogo que se abre, escolha o local onde o arquivo
está gravado (no CD que acompanha o livro), e clique com o botão do meio (ou Alt+botão
esquerdo) do mouse no nome do arquivo.
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Pratique o que aprendeu até agora com esta cena. Subdivida as janelas 3D de forma
diferente. Junte novamente janelas que estavam divididas. Mude a posição do cabeçalho
da janela 3D, torne-o invisível e retorne com ele à posição original. Mude as vistas de
cada janela para poder compreender melhor a importância de se trabalhar com mais de
uma vista em um projeto 3D.

1.8 VISUALIZAÇÃO

Nós podemos escolher o tipo de visualização que queremos ver em cada janela, de
modo a economizar o tempo de processamento do computador. Quanto mais qualidade

tiver a imagem vista na janela, mais tempo irá demorar
para ser redesenhada quando for feita alguma
modificação na cena. Em cenas complexas, o tempo de
redesenho na janela de visualização pode se tornar um
problema. Se for este o caso, mude o tipo de modo de
visualização clicando no botão correspondente (Figura
1.13). Há cinco modos diferentes, aumentando na
qualidade à medida que se sobe na lista.

O método mais rápido é o Bounding Box, que mostra uma caixa que contém o objeto. É
um método rápido de se verificar a posição e o movimento de objetos, e pode ser usado
para se testar animações complexas (Figura 1.14).

O modo Wireframe  (fio de arame) desenha o objeto usando linhas para representar as
bordas visíveis dos polígonos, fazendo os objetos se parecerem com esculturas de arame.
Este modo possibilita a visão da forma real do objeto e permite acesso aos seus vértices
individuais para edição e modificação (Figura 1.15).

Fig. 1.13:
Modos de
visualização.

Fig. 1.14: Modo
Bounding Box.

Fig. 1.15: Modo
Wireframe.
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Já o modo Solid (sólido) representa o objeto como se fosse um bloco sólido, mostran-
do as faces externas da sua geometria. Neste modo já podemos ver as cores dos obje-
tos. Eles aparecem facetados, mas pela primeira vez é possível se ver os brilhos da luzes
refletindo nos objetos (Figura 1.16).

Para uma visão um pouco mais realista, o modo Shaded (sombreado) mostra a textura
escolhida aplicada sobre a superfície do objeto, além de renderizar a iluminação de
forma bem mais convincente (Figura 1.17). Texturas serão vistas em um módulo futuro
mais avançado. Neste curso introdutório não serão abordadas.

O último modo, chamado de Textured, (texturizado) permite a visualização de texturas
UV (ver Cap. 3) aplicadas sobre o objeto. Atenção, se não houver nenhuma luz, a janela
aparecerá totalmente negra (Figura 1.18).

Abra novamente o arquivo tresjanelas.blend como já fez anteriormente e modifique o
modo de visualização das janelas. Experimente cada um deles e observe como os objetos
se apresentam. Você não conseguirá ver ainda uma textura UV no modo Textured, pois
este assunto será abordado mais à frente em detalhes, ainda neste curso.

Fig. 1.16: Modo
Solid.

Fig. 1.17: Modo
Shaded.

Fig. 1.18: Modo
Textured.
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1.6 NAVEGAÇÃO EM 3D.

Muitas vezes é necessário mudar o ângulo de visualização de uma janela para que pos-
samos enxergar melhor as posições relativas entre os objetos da cena. Podemos facil-
mente fazer isso utilizando as teclas numéricas, que irão movimentar ou rotacionar o
seu ponto de vista sem alterar a posição de nenhum componente da cena. É importante
ter em mente que as mudanças de ponto de vista aqui descritas não afetam de maneira
alguma os objetos existentes na cena (nem a sua posição, nem a sua forma), apenas
alteram a forma de visualizá-los. A vista pode ser considerada como uma janela para o
mundo e é você quem vai se movimentar em relação a essa janela. Para os exercícios de
navegação iremos usar o arquivo suzanne.blend, que se encontra no CD que acompanha
o livro (Figura 1.19). Abra esse arquivo do modo que aprendeu anteriormente.

Há dois tipos de vistas: local e global. O modo de vista local (View>Local View),  faz com
que somente os objetos selecionados sejam visíveis, facilitando a edição de cenas com
muitos objetos. Para entrar no modo de vista local, selecione a cara de macaco maior,
clicando nela com o botão direito do mouse, e depois clique em View>Local View, no
Header da janela 3D. Observe como a cara menor, a câmera e a luz se tornaram invisí-
veis. Eles não foram apagados da cena, apenas não podem ser vistos. Para voltar ao
modo de vista global, clique em View>Global View. Agora todos os objetos podem ser
vistos novamente. O modo de vista local também pode ser trocado com o modo de vista
global através da tecla / do teclado numérico.

Ative a tecla NumLock  do seu teclado e utilize as teclas 4 e 6 para orbitar para a
esquerda ou para a direita, e as teclas 8 e 2 para orbitar para cima e para baixo. O efeito
é como se o observador girasse em torno do ponto selecionado. Para efetuar uma
panorâmica são utilizadas as mesmas teclas, só que juntas com a tecla Ctrl. Nesse caso a
janela mostra um deslocamento em linha reta do ponto de vista do observador na
vertical ou na horizontal (Figura 1.20).

Fig. 1.19:
Arquivo
suzanne.blend.

Fig. 1.20:
Orbitar e
Panorâmica
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No caso do nosso exemplo, tente orbitar o ângulo de visão da cena de modo a conse-
guir o resultado da figura 1.21.

Depois volte para a vista frontal teclando 1, e faça uma panorâmica (Figura 1.22).

As teclas + e – são usadas para efetuarmos um zoom, positi-
vo ou negativo. Se o seu mouse tiver um rolete, ele também
pode ser utilizado para as operações de zoom. A tecla Enter
do teclado numérico neutraliza as operações de zoom. É im-
portante assinalar que a operação de zoom não altera as
dimensões do objeto observado, tal como o faria a operação
de escala, apenas aproxima ou afasta o ponto de vista do
observador (Figura 1.23).

Volte para a vista frontal teclando 1 e faça um zoom na ima-
gem utilizando os recursos descritos (Figura 1.24).

Fig. 1.21:
Orbitando em
torno da cena.

Fig. 1.22:
Fazendo uma
movimentação
panorâmica.

Fig. 1.23: Zoom

Fig. 1.24:
Fazendo um
zoom na
imagem.
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No teclado numérico, a tecla 5 muda de uma vista ortográfica, sem distorções projetivas,
para uma vista em perspectiva, onde as linhas convergem para um ponto de fuga (Figu-
ra 1.25).

As opções de navegação que foram mostradas também podem ser acessadas pelo menu
View > View Navigation, no cabeçalho da janela 3D (Figura 1.26).

O Blender também oferece um recurso de orientação rápi-
da, chamado de alinhamento de vista (Align View). Para
centrar a vista na posição do cursor, tecle C. Para mostrar
todos os objetos da cena centrados na vista, tecle Shift+C.
Para alinhar a câmera ativa à vista, tecle Ctrl+Alt+0. Para
alinhar a vista ao objeto selecionado, tecle * (no teclado
numérico). Experimente essas alternativas com o arquivo
Suzanne.

Se estiver perdido em uma cena grande, onde os objetos
desejados estão fora de vista, tecle Home para ver todos

os objetos enquadrados na janela. Estas opções também estão no menu View > Align
View do cabeçalho da janela 3D (Figura 1.27).

Fig. 1.25:
Vista em
perspectiva.

Fig. 1.26:
Menu de
navegação 3D.

Fig. 1.27:
Menu de
alinhamento de
vistas.
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MÓDULO 2:
CURVAS E SUPERFÍCIES. CURVAS BÉZIER. CURVAS NURBS. EXTRUSÃO.

2.1. CURVAS E SUPERFÍCIES

A modelagem de objetos tridimensionais normalmente pode fazer uso de dois métodos
principais de construção de objetos: malhas 3D (meshes) ou curvas e superfícies. As
malhas 3D são definidas a partir de pontos chamados vértices que são unidos por linhas
chamadas arestas, que constroem planos que são chamados de faces (ver figura 1.2). Os
vértices podem ser deslocados individualmente ou em grupo, permitindo um ajuste
bastante preciso da forma do objeto desejado.

Já as curvas e superfícies que podem ser criadas no espaço tridimensional são construídas
a partir de fórmulas matemáticas, ao invés de uma série de pontos como são construídas
normalmente as malhas 3D (meshes). Existem dois tipos de curvas e superfícies utiliza-
das pelo Blender: curvas do tipo Bézier e curvas do NURBS. Ambos os tipos de curvas
são B-Splines, que são definidas através de um conjunto de vértices de controle que
definem a forma da curva. As curvas são construídas através de interpolação (Bézier)
ou ‘atração’ (NURBS).

Uma das vantagens de se utilizar curvas e superfícies é que elas utilizam menos dados,
produzindo bons resultados usando pouca memória e tempo de modelagem. A
contrapartida é a maior demora de tempo de renderização, devido às exigências de um
maior tempo de computação. Como desvantagem, as curvas não permitem o ajuste fino
vértice a vértice que uma malha 3D permite, mas elas são a única maneira de se modelar
um objeto utilizando o recurso de extrusão ao longo de uma linha. (ver seção 2.4) Há
momentos em que um ou outro método será mais recomendável, mas apenas a experiência
será capaz de tornar a escolha mais eficiente.

2.2. CURVAS BÉZIER

A maior utilidade das curvas Bézier é para a construção de objetos a partir de desenhos
2D, construção de objetos extrudados e determinação de caminhos (paths) para o mo-
vimento de objetos.

Uma curva Bézier é definida através de pontos de controle, onde cada ponto possui
dois pontos de ajuste. Ao ser selecionado um ponto de controle, seus pontos de ajuste
são também selecionados. Quando movemos o ponto de controle central, todo o par de
pontos de ajuste se move junto com ele. Se movermos os pontos de ajuste, clicando e
arrastando, podemos mudar a forma da curva naquele ponto. Uma curva Bézier é tan-
gente à linha que vai do ponto de controle até o ponto de ajuste, e pode ter sua
suavidade controlada através da manipulação do comprimento desta linha.

Como exercício, vamos criar uma curva Bézier. Vá ao menu na parte superior da janela
3D, clique em Add, Curve>Bézier curve. Ao fazer isso, surgirá na tela uma curva Bézier
com dois pontos de controle amarelos, cada um ligado por uma linha rosa a dois pontos
de ajuste, também amarelos (Figura 2.1).
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Novos pontos de controle podem ser adicionados a esta linha, selecionando-se primeiro
um ponto com o botão direito do mouse e clicando-se depois Ctrl+botão esquerdo do
mouse (Figura 2.2). Para apagar um ponto basta selecioná-lo, clicar Del e confirmar.

Para mudar a forma da curva em um ponto, selecione um ponto de ajuste com o botão
direito do mouse e movimente-o clicando com o botão esquerdo do mouse (dentro do
círculo para movimentar livremente, nas setas para restringir o movimento à direção do
eixo correspondente), até que curva esteja na forma desejada (Figura 2.3).

Existem quatro tipos de pontos de ajuste, cada um deles fazendo a curva se comportar
de um modo diferente. Eles são diferenciados por cores para ajudar na sua identificação.

Free Handle (preto) – Possibilita a manipulação da curva com mais liberdade, permitin-
do fazer até mesmo pontas agudas em uma curva. Selecione o ponto desejado com o
botão direito do mouse e depois tecle H. Depois selecione o ponto de ajuste com o botão
direito do mouse e movimente-o clicando com o botão esquerdo do mouse (Figura 2.4).

Fig. 2.1:
Curva Bézier.

Fig. 2.2:
Adicionando
pontos de
controle.

Fig. 2.3:
Movimentando
um ponto de
ajuste.
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Aligned Handle (púrpura) – Este tipo de ponto de ajuste sempre se mantém alinhado
com seu oposto, não importa o movimento que se faça. Selecione o ponto com o botão
direito do mouse e depois tecle H. A tecla H transforma um ponto Free em Aligned e
vice-versa. Depois selecione o ponto de ajuste desejado com o botão direito do mouse
e movimente-o clicando com o botão esquerdo do mouse (Figura 2.5).

Vector Handle (verde) – Neste caso os pontos de ajuste de um ponto de controle
sempre apontam para o ponto de ajuste anterior ou então para o próximo. Selecione o
ponto com o botão direito do mouse e depois tecle V. Depois selecione o ponto de
ajuste desejado com o botão direito do mouse e movimente-o clicando com o botão
esquerdo do mouse. Quando um Vector Handle é movido, ele se transforma em um Free
Handle (Figura 2.6).

Fig. 2.4: Curva
Bézier, Free
Handle.

Fig. 2.5: Curva
Bézier, Aligned
Handle.

Fig. 2.6: Curva
Bézier, Vector
Handle.
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Auto Handle (amarelo) – Esta opção faz com que o Blender escolha automaticamente
as posições dos pontos de ajuste, de modo a obter uma curva mais suave naquele
ponto. Selecione o ponto com o botão direito do mouse e depois tecle Shift+H. Depois
selecione o ponto de ajuste desejado com o botão direito do mouse e movimente-o
clicando com o botão esquerdo do mouse. Quando um Auto Handle é movido, ele se
transforma em um Aligned Handle (Figura 2.7).

Para que uma curva Bézier seja visível na janela de renderização é necessário dotá-la de
espessura. Podemos conseguir isto na aba Curve and Surface, do botão Editing, na
janela de botões. As variáveis Ext1 e Ext2 controlam o volume da curva. Variáveis
numéricas na interface do Blender podem ser alteradas com o mouse, clicando-se em
uma das minúsculas setas à esquerda ou à direita do nome da variável, e movendo-se o
mouse para a esquerda ou para a direita, mantendo-se o botão apertado. Outra maneira
é clicar sobre a variável usando Shift+botão esquerdo do mouse e digitar o valor numérico
diretamente. Para melhorar a suavidade da curva renderizada, é necessário aumentar o

valor de DefResolU para um número maior do que seis. Esta
variável representa o número de pontos calculados entre
cada par de pontos de controle da curva. Aumentá-la faz
com que a curva seja dividida em um número maior de
partes, aumentando a sua resolução e fazendo com que sua
imagem renderizada se apresente mais suave e com menos
angulosidades (Figura 2.8).

Podemos criar mais pontos de controle numa curva, se for
necessário fazer ajustes mais finos na sua forma. Para isto basta selecionar dois ou mais
pontos de controle usando Shift+botão direito do mouse, depois clicar a tecla W e
confirmar a opção Subdivide (Figura 2.9).

Fig. 2.7: Curva
Bézier, Auto
Handle.

Fig. 2.8:
Resolução e
espessura da
curva.

Fig. 2.9:
Subdividindo uma
curva Bézier em
mais pontos de
controle.
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Podemos também fechar uma curva unindo seu ponto inicial ao seu ponto final. Para
isso basta selecionar pelo menos um dos pontos de controle da curva e depois clicar a
tecla C (Figura 2.10).

Com a curva fechada podemos criar uma figura plana, clicando no botão Back ou Front
da figura 2.8. O resultado pode ser visto na figura 2.11.

Se outra curva Bézier fechada for criada dentro da anterior, o Blender faz automatica-
mente um buraco (Figura 2.12).

Fig. 2.10: Curva
Bézier fechada.

Fig. 2.11: Curva
Bézier fechada
transformada em
superfície.

Fig. 2.12:
Buraco com
curvas Bézier.
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2.3 CURVAS NURBS

NURBS é uma abreviação de Non Uniform Rational B-Splines. São formas matemáticas
puras, geradas por equações polinomiais e controladas por uma série de variáveis que
permitem a geração de curvas extremamente precisas.

Os controles de uma curva NURBS são diferentes dos controles de uma curva Bézier.
Primeiro vamos criar uma curva NURBS. Clique em Add, Curve>NURBS Curve. Surgirá
uma curva em preto, cercada por uma moldura de controle em amarelo, segmentada por
pontos em rosa (Figura 2.13).

Essa linha amarela controla a forma da curva NURBS, através de um efeito de ‘atração’.
Selecione um dos pontos de controle dessa linha com o botão direito do mouse e
movimente-o clicando com o botão esquerdo do mouse e arrastando. A curva muda a
sua forma de acordo com a posição dos pontos da moldura de controle (Figura 2.14).

Há uma série de parâmetros de controle para uma curva NURBS que podem ser acessados
pela aba Curve Tools na janela de botões (Figura 2.15).

Fig. 2.13:
Curva NURBS.

Fig. 2.14:
Modificação de
uma curva
NURBS.

Fig. 2.15:
Parâmetros de
controle de uma
curva NURBS.
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Make Knots – As curvas NURBS são definidas através de um conjunto de números que
especificam a definição paramétrica da curva. Esse conjunto é chamado de Knot vector,
ou vetor de nós. Há aqui duas opções importantes para se estabelecer o comportamento
da curva. Uma é a opção Uniform, que produz uma divisão uniforme para curvas fecha-
das, mas que deixa ‘pontas soltas’ quando utiliza curvas abertas, tornando difícil a
localização precisa dos vértices inicial e final da curva (Figura 2.16).

Já a opção Endpoint ajusta os nós de modo que o primeiro e o último vértice façam
sempre parte da curva, o que os torna mais fáceis de ser manipulados (Figura 2.17).

Order – Este parâmetro pode ser visto como um controle da ‘profundidade’ do cálculo
da curva. O valor ‘1’ representa um ponto, ‘2’ é linear, a ordem de valor ‘3’ é quadrática,
e assim por diante. É aconselhável sempre utilizar o valor de order ‘5’ para a construção
de paths (ver item 2.4 - Extrusão) , porque assim ele se comporta de modo suave sob
qualquer circunstância, sem produzir descontinuidades no movimento.

Weight – Cada vértice de uma curva NURBS possui um ‘peso’, que determina a força
com que esse vértice participa na ‘atração’ da curva. Quanto maior esse valor, mais a
curva será ‘atraída’ para o vértice em questão (Figura 2.18).

Fig. 2.16:
Curva NURBS,
opção
Uniform.

Fig. 2.17:
Curva NURBS,
opção
Endpoint.

Fig. 2.18:
Curvas NURBS
com diferentes
valores de
Weight para o
vértice
central.
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Os comandos para fechamento de curvas e subdivisão de vértices da linha de controle
se comportam exatamente como para as curvas Bézier.

2.4 EXTRUSÃO

A ferramenta de extrusão ao longo de um path, ou caminho, é um importante recurso
de modelagem em programas 3D. Ele faz uso de uma forma bidimensional que se desloca
ao longo de uma linha no espaço, construindo a estrutura tridimensional desejada.
Tanto a forma bidimensional quanto o path podem ser feitos de linhas Bézier ou NURBS.
Vamos começar com um círculo e uma linha Bézier. Clique em Add, Curve>Bézier Circle,
clique Tab para voltar ao modo objeto e A para deselecionar tudo. Depois posicione o
cursor 3D um pouco mais à direita, clicando lá com o botão esquerdo do mouse e clique
em Add, Curve>Bézier Curve (Figura 2.19).

Divida a janela 3D em três, como nos exercícios iniciais e escolha uma vista diferente
para cada uma delas. Agora modifique a curva adicionando vértices e movimentando-a
no espaço tridimensional clicando com o botão do meio do mouse (ou Alt+botão es-
querdo do mouse) em uma das vistas, e movendo o mouse enquanto ele continua pres-
sionado. Para isso é essencial acionar antes o botão 3D na aba Curve and Surface, pois
se isso não for feito, a curva Bézier irá permanecer bidimensional (Figura 2.20). Obser-
ve como a curva se modifica em cada uma das janelas, permitindo uma compreensão
melhor da sua forma no espaço.

Agora selecione apenas o círculo, que é o objeto que
queremos extrudar e observe o nome do objeto na aba
Link and Materials. No nosso caso o nome do objeto é
CurveCircle. Se necessário esse nome pode ser mudado,
clicando no local do nome e digitando outro (Figura
2.21).

Fig. 2.19:
Círculo Bézier
e curva Bézier.

Fig. 2.20:
Curva Bézier
no espaço 3D.

Fig. 2.21:
Nome do
objeto a ser
extrudado.
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Agora selecione apenas a curva que servirá como path.
Localize o botão BevOb na aba Curve and Surface da
janela de botões. Clique no espaço à frente e digite o
nome do objeto que será extrudado, no nosso caso,
CurveCircle (Figura 2.22).

Ao fazer isso aparece imediatamente a forma que comandamos. O círculo se move ao
longo da curva, construindo uma estrutura tridimensional no seu rastro (Figura 2.23).

Movimente-se em torno do objeto criado utilizando os recursos de mudanças de ponto
de vista que já aprendeu, para sentir a tridimensionalidade do mesmo.

Fig. 2.22:
Nome do
objeto a ser
extrudado ao
longo do path.

Fig. 2.23:
Objeto
extrudado.
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MÓDULO 3:
MODELAGEM EM 3D - PRIMITIVAS BÁSICAS – PLANO, CUBO, CÍRCULO, ESFERA UV, ICOSFERA,
CILINDRO, TUBO, CONE, GRADE, MACACA, TEXTO.

3.1 MODELAGEM EM 3D - PRIMITIVAS BÁSICAS.

Em desenho tridimensional computacional, utilizamos formas geométricas básicas para
construir estruturas que irão se tornar os objetos
desejados, depois de serem unidas, divididas,
transformadas e editadas. Estas formas geométricas
básicas são chamadas de primitivas. No Blender elas
são o plano, o cubo, o círculo, a esfera UV, a icoesfera,
o cilindro, o tubo e o cone.

A caixa de ferramentas (Toolbox) possui a maioria das
funções de criação de objetos mais utilizadas pelo
Blender. Ela pode ser ativada teclando-se a barra de
espaços ou clicando-se o botão esquerdo ou direito
do mouse mais demoradamente sobre a janela 3D.
Também podemos usar o atalho Shift-A ou a tecla

Space para a mesma função (Figura 3.1).

A janela cinza menor lista as funções principais. Ao se passar o mouse sobre elas, abre-
se uma nova janela com opções daquela função principal. Algumas opções abrem ainda
uma terceira janela, indicada por uma seta preta apontando para a direita. Um clique
com o botão esquerdo do mouse escolhe a opção desejada.

Sempre que um novo objeto é criado no Blender ele surge no modo de edição, com seus
vértices marcados por pontos amarelos. Este modo será explicado mais à frente no
módulo 5. É preciso mudar para o modo objeto apertando a tecla Tab antes de criar

outro objeto, caso contrário eles ficarão ligados como
um objeto único. Geralmente é interessante criar o
objeto na vista de topo, que o deixará alinhado com
uma referência mais clara.

Em todos os exemplos citados abaixo, os objetos são
criados pelo Blender com um tamanho padrão. Para
que possamos assinalar valores específicos para as
dimensões dos objetos, é necessário colocar o objeto
recém-criado no modo objeto (Tecla Tab) e clicar a
tecla N em seguida. Isto abre uma janela de diálogo

que permite determinar o nome do objeto, sua posição, rotação e escalamento em todos
os três eixos, X, Y e Z (Figura 3.2).

Podemos também mudar o nome do objeto se for desejado, escrevendo no campo OB o
novo nome. Para fechar a janela basta teclar no X acima, à esquerda da janela.

Fig. 3.1:
Toolbox.

Fig. 3.2:
Janela de
propriedades
do objeto.
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À medida em que cada item a seguir for explicado, crie um objeto para exercitar o seu
conhecimento.

Plano (Plane) – Este é um plano simples, com quatro vértices nos cantos. Para se criar
um plano, primeiramente deve-se posicionar o cursor no ponto da janela onde se quer
que o plano seja criado. Clique a barra de espaços e escolha a função Add, Mesh > Plane
e o plano será criado.

Cubo (Cube) - Um cubo pode ser criado da mesma forma. Repita as operações, e na
opção Mesh escolha Cube.

Círculo (Circle) - Esta função cria um círculo bidimensional no espaço tridimensional.
Repita as operações, e na opção Mesh escolha Circle.

Esfera UV (UV Sphere) - A esfera UV é uma esfera dividida em segmentos retangulares
latitudinais e longitudinais. Devido a este tipo de construção, ela tem um número maior
de vértices nas regiões próximas aos pólos. Para criar uma esfera UV, primeiramente
deve-se clicar no ponto da janela onde se quer que a esfera seja criada. Depois ao clicar
a barra de espaços, escolhemos a função Add, e depois a função Mesh. Escolha a opção
UV Sphere e logo surgirá uma janela perguntando o número de segmentos (Segments)
e o de anéis (Rings). Os segmentos são linhas que unem os pólos da esfera, dividindo-
a como os gomos de uma laranja. Já os anéis dividem a esfera com linhas circulares
perpendiculares aos segmentos. Estes valores determinam a subdivisão da esfera em
círculos semelhantes às linhas de latitude e longitude da Terra. Quanto maiores forem
esses números, mais suave será a aparência da esfera, mas também mais demorada será
a renderização do objeto, por necessitar de um número maior de cálculos realizados
pelo computador devido ao aumento da complexidade da sua malha. A esfera surgirá
no ponto onde o cursor se encontra.

Icosfera (Icosphere) – A Icosfera possui uma estrutura que tem uma subdivisão
geodésica em triângulos, o que distribui seus vértices de forma homogênea por toda a
esfera. Sua construção se dá da mesma forma que a Esfera UV, só que surgirá a opção
Subdivision, que irá determinar o grau de subdivisões (número de triângulos) da icosfera.
Quanto maior o número, mais subdividida aparecerá a superfície.

Cilindro (Cilinder) – Para criar um cilindro, siga os passos tradicionais e opte pelo
número de vértices que irão determinar a suavidade da curvatura do cilindro. A forma é
gerada por aproximação. Se forem usados números pequenos, a forma gerada será de
um prisma com o mesmo número de lados que o número de vértices. Quanto maior for
o número de vértices, mais a forma se aproximará de um cilindro verdadeiro.

Tubo (Tube) - Para criar um tubo, siga novamente os passos tradicionais e opte pelo
número de vértices que irão determinar a suavidade da curvatura do tubo.

Cone (Cone) - Os passos para se criar um cone são semelhantes aos anteriores, com
uma opção para o número de vértices que irão determinar a suavidade da curvatura do
cone.

Grade (Grid) – Cria uma grade retangular com número de vértices à escolha, tanto no
eixo X, quanto no eixo Y. Siga os passos anteriores e faça suas opções.

Macaca (Monkey) – Cara de macaca. Não possui variáveis. Seu nome é Suzanne.
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3.2 TEXTO

O texto é tratado no Blender como um tipo especial de curva. Em computação, chama-
mos de fontes as famílias de letras que possuem um mesmo estilo. Uma fonte é um
arquivo digital que contém a definição gráfica de todas as letras e símbolos de acentu-
ação de um alfabeto em um estilo específico. Existem várias maneiras diferentes de se
codificar um arquivo de fonte. Há uma fonte interna simples utilizada pelo Blender, mas
ele também aceita fontes do tipo Post-Script Type 1 ou True Type. Para carregar uma
nova fonte, clique no botão Load, da aba Font, e localize a pasta com as fontes em seu
disco rígido ou outro meio de armazenamento. No CD que acompanha o livro fornecemos
alguns exemplos de algumas fontes True Type. Fontes True Type tem como extensão de
arquivo a sequência .ttf. Já as fontes Post-Script possuem a extensão .ps. Para criar um
texto no Blender, basta clicar na janela 3D, apertar a barra de espaços e escolher Add>Text.
A partir daí é só escrever o texto desejado, que será escrito onde o cursor de texto estiver
indicando. Quando estiver satisfeito, clique Tab para sair do modo de edição. O texto
criado é plano, mas pode adquirir volume através dos controles Ext1 e Ext2, da aba Curve
and Surface. A variável Ext1 controla a espessura da letra e a variável Ext2 controla a
largura do chanfrado das quinas das letras. Já a variável BevResol muda suavemente de
um chanfrado reto para um chanfrado curvo (Figura 3.3).

Procure criar um texto 3D seguindo as instruções anteriores e tente fazer com que ele se
pareça com a figura 3.3 (Dica: use a fonte Times.ttf). Modifique os valores das variáveis
que controlam a espessura das letras, a largura do chanfrado das quinas e a transforma-
ção de um chanfrado reto para um curvo. Observe como o objeto se altera. Navegue em
torno do objeto no espaço 3D para observar seus detalhes. Utilize o zoom para se
aproximar e verificar detalhes.

Fig.  3.3:
Criação de texto
3D.
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MÓDULO 4:
TRANSFORMAÇÃO DE OBJETOS. PIVOTS E OUTROS PONTOS DE REFERÊNCIA.

4.1 TRANSFORMAÇÃO DE OBJETOS.

Para efetuar qualquer operação sobre um objeto, é preciso que antes ele seja seleciona-
do. O Blender faz isso de duas maneiras, uma delas é clicando-se o botão direito do
mouse sobre o objeto desejado. Se quiser selecionar mais de um objeto, aperte a tecla
Shift junto com o botão direito do mouse. O outro modo é teclar B, que acionará o
modo de seleção do tipo janela, que irá selecionar todos os objetos que se encontrarem
dentro da janela marcada pelo mouse. Para selecionar ou deselecionar todos os objetos
da cena, tecle A.

No Blender nós podemos manipular o objeto criado através de operações de translação,
rotação ou escalamento, que não alteram as propriedades globais do objeto, ou então
podemos alterar parâmetros que mudam as suas propriedades globais, tais como
deformar o objeto ou parte dele. Quando estamos no chamado modo objeto, as operações
realizadas são do primeiro tipo. Nesse caso podemos movimentar (Tecla G), rotacionar
(Tecla R) ou escalar (Tecla S) um objeto selecionado, operações que atuam sobre o
objeto como um todo. Teclando Ctrl+Space podemos também acessar um menu com
essas funções. As mesmas opções se encontram em um conjunto de botões no cabeçalho
da janela de botões (Figuras 4.1 e 4.2).

Quando rotacionamos um objeto, três fatores irão in-
fluenciar a maneira como ele irá girar:

• O sistema de coordenadas escolhido (Normal, Local
ou Global);

• A localização do centro de rotação, chamado de pivot;

• O eixo de rotação escolhido, X, Y ou Z.

Quando efetuamos uma transformação em um objeto, é necessário dizer qual é o siste-
ma de coordenadas ao qual ele será referenciado. Se escolhermos a opção Global, todas
as alterações se darão com referência ao ponto de origem 0,0,0, na interseção dos eixos
X, Y e Z. Se a escolha for Local, a referência será o ponto em que o objeto se encontrava
antes da operação (Figura 4.3).

Fig. 4.1: Menu
acionado por
Ctrl+Space.

Fig. 4.2: Botões
de edição na
barra do
cabeçalho.
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A escolha do pivot irá determinar o ponto em relação
ao qual será efetuada a rotação. Já a escolha do eixo
determinará em torno de qual dos três eixos (X, Y ou
Z) o objeto será rotacionado, obedecendo ao ponto
de referência do pivot escolhido.

Podemos dizer ao Blender qual a quantidade exata de
transformação que queremos que o objeto sofra,

entrando com dados numéricos. Para isso basta selecionar o objeto (no modo objeto)
e teclar N. A janela semitransparente que se abre permite a entrada de dados teclando-
se Shift+botão esquerdo do mouse sobre o número que se queira modificar.

4.2 PIVOTS E OUTROS PONTOS DE REFERÊNCIA.

Quando efetuamos algumas operações sobre um ob-
jeto, tais como rotação, escalamento ou translação,
além de outras, temos que dizer qual é o ponto de
referência em relação ao qual será realizado o
comando (Figura 4.4).

O Blender oferece cinco opções para a localização de pivots:

Active Object - Escolhe o pivot do objeto ativo como ponto de referência para as
transformações desejadas. O objeto ativo é o último que foi selecionado;

Individual Object Centers - Escolhe os centros individuais dos objetos selecionados
como ponto de referência para as transformações desejadas;

3D Cursor - Escolhe a posição do cursor 3D como ponto de referência para as transfor-
mações desejadas;

Median Point - Escolhe o ponto médio do objeto ou objetos selecionados como ponto
de referência para as transformações desejadas;

Bounding Box Center - Escolhe o centro de uma caixa imaginária que contém os obje-
tos selecionados como ponto de referência para as transformações desejadas;

Às vezes podemos ter dificuldades para selecionar
um objeto. Se for difícil clicar na sua linha de
contorno, há um ponto de referência do centro de
cada objeto, que se parece com uma minúscula esfera.
Esse ponto pode ser utilizado para a seleção de
objetos, clicando-se nele com o botão direito do
mouse (Figura 4.5).

Fig. 4.3:
Sistemas de
coordenadas.

Fig. 4.4:
Opções de
pivots.

Fig. 4.5:
Centro de um
objeto.
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As transformações descritas podem ser efetuadas tam-
bém com o mouse. Crie, em uma janela com vista de
topo, uma Icosfera com duas subdivisões (Add,
Mesh>Icosphere). Quando um objeto é selecionado
nesta vista, aparecem dois eixos, um vermelho (Eixo
X) e um verde (Eixo Y) que se encontram em um ponto
azul (Figura 4.6). Na verdade o ponto azul não é um
ponto, mas o eixo Z visto de frente.

Para que fique mais claro, clique na janela 3D com o
botão do meio (ou Alt+botão esquerdo) do mouse,
mantenha o botão pressionado e movimente o mouse.
Veja como o eixo Z se revela quando a vista se altera
(Figura 4.7).

Esse código de cores nunca se altera, para que você
tenha mais um sistema de referência para compreender
sua posição no mundo e guiar suas transformações.
Agora clique com o botão esquerdo do mouse sobre o
eixo X. Não é preciso manter o botão pressionado,
apenas dar um clique sobre a linha vermelha. Agora
veja como apenas o eixo que você escolheu se torna
cinza, enquanto os outros desaparecem (Figura 4.8).
Isto é para que você saiba que a transformação que
você irá fazer irá atuar apenas sobre o eixo X, que se
encontra “travado”.

Ao movimentar o mouse nesse momento, o objeto
será deslocado sobre o eixo X, e o valor numérico de
sua movimentação aparece no canto esquerdo do
cabeçalho da janela 3D, identificando também o eixo
utilizado (Figura 4.9).

A forma dos eixos apresenta-se diferente para cada tipo de transformação escolhida. Na
figura 4.10 podemos ver como eles se mostram nas operações de movimentação, rotação
e escalamento. Para qualquer uma delas a operação é similar, escolhendo-se o eixo da
operação com um clique do botão esquerdo e movimentando o mouse. Já o círculo
branco visto junto aos eixos possui funções um pouco diferentes em cada um dos

Fig. 4.6:
Objeto
selecionado na
vista de topo.

Fig. 4.7: Eixo
Z revelado.

Fig. 4.8: Eixo
X “travado”.

Fig. 4.9: Valor
numérico do
deslocamento
no eixo X.
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casos. Quando estamos efetuando uma movimentação, ao clicar no círculo branco ou na
área dentro dele podemos mover o objeto livremente em qualquer direção desejada na
janela em foco. Se você quiser deslocar o objeto por múltiplos de unidades inteiras,
basta clicar a tecla Ctrl junto com o botão esquerdo do mouse ao selecionar o eixo
desejado, e mantê-la clicada enquanto move o objeto. No caso da rotação, o círculo
branco permite rotacionar o objeto em torno do centro do círculo na janela escolhida.
Se clicarmos juntamente a tecla Ctrl nesse momento, a rotação se efetua em múltiplos
de cinco graus. Na operação de escalamento o círculo branco permite o escalamento
simultâneo em todos os eixos. Neste caso a tecla Ctrl não tem função alguma.

Fig. 4.10: Forma
dos eixos de
acordo com a
operação de
transformação.
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MÓDULO 5:
AGRUPAMENTO DE OBJETOS (PARENTING). LAYERS.
EDIÇÃO DE  OBJETOS. DUPLICAÇÃO DE OBJETOS.

5.1 AGRUPAMENTO DE OBJETOS (PARENTING)

Uma função muito útil encontrada em vários programas de modelagem 3D é a de agrupa-
mento. Quando agrupamos objetos, eles se comportam como se fossem um só. As
alterações aplicadas produzem efeitos sobre todo o grupo. O Blender não possui uma

função específica para agrupamento. No Blender essa
função é realizada pelo parenting, que na realidade
faz mais do que um simples agrupamento de objetos,
criando uma hierarquia entre eles.

Vamos criar dois objetos, um cubo e uma esfera UV (Add,
Mesh>Cube e depois Add, Mesh>UVSphere). O parenting
estabelece uma ligação entre um objeto-pai e um ou mais
objetos-filho. Para isso basta selecionar os dois objetos
e clicar Ctrl+P, confirmando a opção Make Parent?, Nor-
mal Parent. O objeto ativo, que foi selecionado por úl-
timo, será o pai de todos os outros que forem ligados a
ele desta forma. O centro de todos os objetos-filho são
mostrados agora ligados ao centro do objeto-pai atra-
vés de uma linha pontilhada (Figura 5.1).

A partir de agora, qualquer operação de movimentação, rotação ou escala sobre o obje-
to-pai será refletida em todos os objetos-filho. Embora esse conceito seja de fácil com-
preensão, à medida em que a cena se torna complexa as hierarquias formadas podem se
tornar bastante complicadas. Então é recomendável seguir algumas estratégias que
possam facilitar o nosso trabalho futuro.

A primeira delas é abrir uma vista do Outliner clicando-se Shift+F9. O Outliner é uma
janela que mostra as ligações hierárquicas existentes entre os objetos da cena. Os
elementos deste gráfico, representados por retângulos chamados de data blocks, po-
dem ser movimentados, selecionando-se o bloco com o botão direito do mouse e teclando
a tecla G. Clique com o botão esquerdo do mouse para fixar a posição desejada do
bloco. É interessante espaçar melhor os elementos do gráfico para que a hierarquia seja
vista com mais clareza (Figura 5.2).

Fig. 5.1:
Agrupamento
por parenting.

Fig. 5.2: Vista
do Outliner,
mostrando
relações
hierárquicas
entre os objetos
da cena.
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O próximo conselho é dar nomes claros e específicos
para cada objeto da cena na barra de tarefas dos botões
de edição (F9). Se esta regra não for observada ficará
muito difícil a identificação dos objetos a partir dos seus
nomes, e a visualização das hierarquias será confusa. O
quadro à direita indicado na Fig. 5.3 mostra o nome do
objeto ativo, que foi selecionado por último. O quadro à
esquerda nomeia o data block ligado ao objeto. O recur-
so data block (bloco de dados) é mais avançado e não
será visto em detalhes no escopo deste curso.

Uma vez que os objetos da nossa cena estejam estruturados através do parenting, po-
demos efetuar uma seleção de grupos utilizando a tecla Shift+G. O menu Group Selection
(seleção de grupo) oferece as seguintes opções (Figura 5.4):

Children – Seleciona todos os objetos-filho na seqüência hierárquica até a última geração.

Immediate Children – Seleciona todos os objetos-filho do objeto ativo, mas não a
geração seguinte.

Parent – Seleciona o objeto-pai do objeto ativo.

Objects on shared layers     – Esta opção não se relaciona com o recurso de parenting,
selecionando todos os objetos que pertencem ao mesmo layer do objeto ativo.

Para remover uma relação de parenting entre objetos, basta clicar Alt+P. O menu permi-
te as seguintes opções:

Clear parent – Remove a ligação entre o objeto-pai e o objeto-filho, desprezando todas
as mudanças efetuadas sobre este devido à ligação com o objeto-pai. O objeto-filho
retorna à sua localização, rotação e tamanho originais.

Clear parent and keep transformation (Clear Track) - Remove a ligação entre o obje-
to-pai e o objeto-filho, mantendo todas as mudanças efetuadas sobre este, devido à
sua ligação com o objeto-pai.

Clear parent inverse - Posiciona os objetos-filho em respeito ao objeto-pai como se
eles estivessem posicionados no sistema de referência Global. Isto limpa efetivamente
qualquer transformação do objeto-pai dos objetos-filho.

Fig. 5.3:
Dando um
nome ao
objeto.

Fig. 5.4:
Opções de
seleção de
grupo.



Ca
de

rn
os

 de
 In

for
m

áti
ca

43

COMPUTAÇÃO GRÁFICA
Secretaria de Estado de Educação MG

5.2 LAYERS

Quando estamos no modo objeto, há uma série de vinte pequenos botões quadrados na
barra de cabeçalho da janela 3D (Figura 5.5). Cada um desses botões corresponde a um
layer. O layer é como se fosse uma camada de trabalho, uma página virtual onde só se
encontram os objetos que foram criados nela. Todos os objetos criados no mesmo layer
são visíveis simultaneamente. Escolha um dos botões e crie alguns objetos com ele

acionado. Depois desabilite o botão e verá que todos
os objetos ficam invisíveis. Eles continuam lá, apenas
não podem mais ser vistos. Esse é um recurso de valor
inestimável quando precisamos ocultar objetos em uma
cena complexa para trabalhar com mais rapidez. Ou
estabelecer grupos virtuais de objetos que pertencem
a uma construção maior, todos fazendo parte de um
mesmo layer.

Se for necessário visualizar os objetos de mais de um layer simultaneamente, basta
apertar a tecla Shift e clicar nos botões dos layers que você quiser ver com o botão
esquerdo do mouse. Você pode também selecionar um layer através de um atalho no
teclado. Cada número, de 1 a 0 corresponde aos dez primeiros layers da linha de cima.
Teclando Alt+número de 1 a 0, você tem acesso aos outros dez layers da linha inferior.
Para trocar um objeto de layer, basta selecioná-lo, teclar a tecla M e escolher o novo
layer na janela de diálogo, confirmando depois com OK.

5.3 EDIÇÃO DE OBJETOS.

Quando queremos editar apenas uma parte do objeto, é preciso entrar no modo de
edição apertando a tecla Tab ou clicando no botão correspondente na barra do cabeçalho
da janela 3D. Quando fazemos isso, o objeto selecionado é redesenhado destacando-se
seus vértices, ou pontos que compõem sua estrutura, na cor amarela (Figura 5.6). Isto
significa que todos os vértices do objeto estão selecionados. Quando criamos um novo
objeto ele sempre surge no modo de edição. Crie uma esfera UV (Add, Mesh>UVSphere).

Fig. 5.5:
Botões de
Layers.

Fig. 5.6: Modo
de edição (Edit
Mode). Vértices
em amarelo.
Cursor indica
opção no Header.
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Agora mude a vista da janela para Side (View, Side ou
tecle 3 no teclado numérico). A esfera deverá ser vista
como na figura a seguir.

Agora tecle A para deselecionar todos os vértices do
objeto. Ao fazer isso os vértices mudam de cor de
amarelo para lilás (Figura 5.8).

O modo de edição nos permite optar pela edição de vértices,
arestas (ou bordas) ou faces. Essas opções se encontram
no cabeçalho da janela 3D (Figura 5.9). O último botão da
seqüência, representando um cubo, quando habilitado
permite selecionar apenas os vértices que estão visíveis na
tela, e quando desabilitado seleciona vértices através da
espessura do objeto.

Se selecionarmos um dos vértices clicando nele com o botão direito do mouse e moven-
do-o clicando com o botão esquerdo e arrastando, poderemos então movê-lo e fixar
sua posição com um clique do botão esquerdo do mouse, deformando o objeto de
acordo com nossas intenções. Se escolhermos mais de um vértice utilizando a tecla

Shift juntamente com o botão direito do mouse, po-
demos também rotacionar ou escalar os vértices em
relação ao seu ponto mediano. Podemos também apa-
gar conjuntos de vértices escolhidos para fazer bura-
cos no objeto. Os botões que acionam as operações de
edição ficam na barra do cabeçalho, e são os mesmos
que permitem a transformação de objetos, só que agora
eles atuam sobre conjuntos de vértices, arestas ou
faces. As operações de transformação podem ser
também acessadas teclando-se as teclas G para mover,
R para rotacionar ou S para escalar.

Como exercício, certifique-se que o botão que limita a
seleção de vértices aos que estão visíveis esteja

Fig. 5.7: Vista
lateral – todos
os vértices
selecionados.

Fig. 5.8:
Vértices
deselecionados.

Fig. 5.9: Opções
de seleção.

Fig. 5.10:
Apagando um
conjunto de
vértices.
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deselecionado, tecle B para efetuar uma seleção através de uma janela, selecione um
conjunto de vértices perto do topo da esfera clicando com o botão esquerdo e arrastando
(Figura 5.10). Depois aperte a tecla Delete. Confirme a opção Vertices e verá que o
conjunto de vértices selecionados desapareceu, deixando um buraco na esfera. Para
confirmar, mude o seu ângulo de visão usando o botão do meio do mouse (ou Alt+botão
esquerdo), clicando, mantendo pressionado e movendo o mouse (Figura 5.11).

Agora selecione um único vértice na borda circular com
o botão direito do mouse, depois clique com o botão
esquerdo dentro do círculo branco e mova o vértice para
cima, clicando com o botão esquerdo do mouse quando
estiver na posição desejada (Figura 5.12).

A edição de conjuntos de vértices ou de vértices individuais é uma poderosa ferramenta
de modelagem tridimensional, permitindo ajustes finos na forma que se quer construir.

5.4 DUPLICAÇÃO DE OBJETOS

Podemos duplicar um objeto existente selecionando-o no modo objeto e clicando Shift+D.
Isto cria uma cópia idêntica do objeto, na mesma posição do original, e o novo objeto
surge travado no modo de movimentação. Mova o mouse para posicioná-lo onde quiser
e clique com o botão esquerdo para fixá-lo. O novo objeto criado compartilha os atribu-
tos de material, textura e IPO (ver módulo 9) com o objeto original. Se qualquer um
destes atributos for alterado em um dos objetos, o outro também terá este atributo
alterado. Duplique o objeto que usamos no exercício anterior da forma descrita e veja o
resultado.

Pode-se também criar uma Linked Duplicate (duplicata ligada), que não é considerada
uma cópia real, clicando-se Alt+D. Os objetos criados desta forma possuem todos os
seus dados ligados ao objeto original, de modo que uma alteração qualquer em um dos

Fig. 5.11: Buraco
deixado no objeto
após o
apagamento de
vértices
selecionados.

Fig. 5.12:
Movimentando
um único
vértice.
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objetos no modo de edição provoca alterações em todas as cópias ligadas. Duplique
mais uma vez o objeto desta forma (Alt+D), no modo objeto, e mude depois para o
modo de edição (Tab). Efetue qualquer edição sobre vértices e veja como o objeto
duplicado reflete a sua ação (Figura 5.13).

Fig. 5.13:
Duplicata
ligada
refletindo as
ações do outro
objeto.



Ca
de

rn
os

 de
 In

for
m

áti
ca

47

COMPUTAÇÃO GRÁFICA
Secretaria de Estado de Educação MG

MÓDULO 6:
MODELAGEM POR SUBSURF. MODELAGEM DE OBJETOS ORGÂNICOS A PARTIR DE
FORMAS GEOMÉTRICAS BÁSICAS.

Se nós precisamos construir uma forma orgânica e complicada, aparentemente cubos,
esferas e cones não ajudam muito. Felizmente o Blender possui um excelente recurso
para manipular com facilidade malhas complexas e modelar superfícies suaves e com
baixo número de vértices. E tudo isso partindo de qualquer objeto, tais como cubos,
esferas, cones ou qualquer outra Mesh (malha) escolhida.

Utilizando um algoritmo matemático chamado Catmull-Clark Subdivision Surfaces (Subdi-
visão de Superfícies Catmull-Clark), ou SubSurf, o Blender efetua uma subdivisão
da malha de um objeto, suavizando sua superfície e lhe dando uma aparência mais
orgânica.

O processo se baseia no controle de uma malha de baixa resolução, com baixo número
de vértices, que por sua vez define a forma de uma superfície de alta definição, que é o
objeto que estamos modelando. É um procedimento intuitivo e de rápida compreensão,
logo que se começa a exercitar com seus recursos.

A opção SubSurf está na aba Mesh do botão Editing (Figura 6.1). As variáveis numéricas
logo abaixo definem a resolução (ou o nível de subdivisão) da malha do objeto. O
número da esquerda é referente à resolução do objeto na imagem visualizada na janela
3D. O número da direita se refere à resolução na imagem renderizada com F12.

Uma boa maneira de se compreender o efeito SubSurf é utilizar nossa amiga Suzanne, a
cara de macaca. Crie Suzanne, clicando em Add, Mesh>Monkey (Figura 6.2).

Observe bem as linhas amarelas, que são as arestas, ou bordas da malha tridimensional
que define a forma de Suzanne. Agora passe para o modo objeto (Tab) e gire o seu

Fig. 6.1:
SubSurf.

Fig. 6.2:
Suzanne.
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ponto de vista clicando com o botão direito do
mouse (ou Alt+botão esquerdo), mantendo pres-
sionado e movendo o mouse, até que Suzanne se
pareça com a figura 6.3.

Agora ative o modo SubSurf, clicando no botão
correspondente (Veja a figura 6.1). O objeto sobre
o qual o efeito será aplicado é o objeto ativo, ou
seja, o último que foi selecionado. No nosso caso
há apenas um objeto, mas em cenas com vários
objetos esta é a regra. O resultado pode ser visto
na figura 6.4.

Podemos notar que houve uma subdivisão de cada
face que compõe o objeto, fazendo com que a
superfície do objeto apareça menos angulosa e
tornando as curvas mais aceitáveis. Agora
modifique o valor de Subdiv, embaixo, à esquerda
do botão SubSurf, de 1 para 2. O resultado deve
aparecer como na figura 6.5.

Veja que a malha agora aparenta estar mais
subdividida ainda, suavizando mais as curvas do
objeto. Tente o valor 3 para Subdiv (Figura 6.6).

 Fig. 6.3:
Suzanne vista
de outro
ângulo, no
modo objeto.

Fig. 6.4:
Subsurf
acionado,
Subdiv = 1.

Fig. 6.5:
Subsurf
acionado,
Subdiv =  2.

Fig. 6.6:
Subdiv com
valor 3.
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Suzanne agora possui uma forma com curvas suaves
e sem descontinuidades, sem a necessidade de edi-
ções complexas com grande número de vértices.
Entretanto a estrutura geométrica do objeto conti-
nua a mesma, sem que nela tenha sido adicionada
uma única face. Mas como isso é possível, sendo que
parece que o objeto realmente sofreu a adição de
um grande número delas? Mude para o modo de
edição (Tab) e observe bem a imagem do objeto (Fi-
gura 6.7).

Veja que as linhas amarelas que definem as arestas, ou bordas do objeto são exatamen-
te as que existiam originalmente, elas não foram subdivididas. Na verdade elas agora
definem um poliedro (figura geométrica 3D com várias faces) de controle, que define a
forma da malha que estamos visualizando. Selecione um único vértice no topo da testa
de Suzanne clicando com o botão direito do mouse e movimente-o para cima (clique
com o botão esquerdo do mouse no eixo verde e mova). Veja o que acontece com a
malha (Figura 6.8).

Movimentar um vértice ou um conjunto deles deforma a malha SubSurf, que acompanha
a transformação feita sobre os vértices. Aqui nós podemos fazer uma analogia com as
curvas NURBS, onde os vértices de controle exercem um efeito de “atração” sobre a
curva. A diferença é que no SubSurf nós não podemos alterar o valor dessa atração,
como nas curvas NURBS. Mas há inúmeras outras vantagens, pois ao contrário das NURBS,
nós podemos utilizar todos os efeitos de transformação disponíveis sobre os vértices
de controle.

Quando estamos no modo objeto, podemos acionar ou desligar o efeito SubSurf clicando
Shift+O, mas certifique-se de que a janela 3D esteja em foco. O nível de subdivisão da
malha visualizada na janela 3D pode também ser controlado através das combinações
de teclas Ctrl+1 até Ctrl+4. O efeito SubSurf é calculado em tempo real, tanto no modelo
que está sendo construído quanto no momento da renderização, e exige muito trabalho
do computador. Se você quiser um desempenho melhor da sua máquina, não deve utilizar
números de SubSurf muito elevados, principalmente para a visualização em tela.

Crie um plano (Add, Mesh>Plane) e aplique nele o comando SubSurf com diversos valo-
res. Na figura 6.9 podemos ver o que acontece com um plano dividido através do co-

Fig. 6.7:
Poliedro de
controle em
linhas
amarelas.

Fig. 6.8:
Controle da
malha SubSurf.
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mando SubSurf. Não é difícil perceber que na subdivisão de um quadrilátero o número de
faces criadas é de 4^n (quatro elevado a n), onde n é o valor escolhido para SubSurf.

A rápida multiplicação do número de faces e vértices com valores maiores de SubSurf
torna todas as operações de edição e renderização mais lentas, o que nos leva a
aconselhar o uso de valores menores de SubSurf para a visualização e deixar os valores
maiores para a renderização, que dará o resultado visual final.

6.1.MODELAGEM DE UM POLVO COM SUBSURF.

Vamos modelar um animal com formas sinuosas a partir
de figuras geométricas básicas para mostrar o poder do
recurso SubSurf como ferramenta de modelagem. Pri-
meiro crie um círculo com oito vértices na vista de topo
(Add, Mesh>Circle), como na figura 6.10. Use o modo
de visualização Solid.

Agora mude para uma vista de frente (View, Front), e
com todos os pontos selecionados tecle E e em seguida
escolha a opção Edges only. Isto irá extrudar a forma
do círculo dando-lhe uma espessura no espaço
tridimensional (Figura 6.11).

Agora tecle novamente a tecla E, fazendo uma nova
extrusão, como na figura 6.12.

Fig. 6.9: Valores
de SubSurf, de
zero a três,
aplicado sobre
um plano.

Fig. 6.11:
Extrusão do
círculo.

Fig. 6.10:
Círculo com oito
vértices.

Fig. 6.12:
Segunda
extrusão do
círculo.
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Depois efetue uma operação de escalamento nos
vértices, teclando a tecla S e movendo o mouse
(Figura 6.13), fixando a posição desejada com um
clique do botão esquerdo do mouse.

Embora não possa parecer, a forma gerada até aqui servirá
de base para o corpo do polvo, depois que for transformada
por SubSurf. Por enquanto vamos continuar com a definição
dos tentáculos do polvo. Certifique-se que a opção Vertex
select mode está acionada nos botões de tipos de seleção,
assim como o botão que representa um cubo esteja
deselecionado (Figura 6.14). Isto permite que vértices ocul-
tos sejam selecionados juntamente com os visíveis.

Volte para a vista de topo (View, Top) e selecione
os vértices mostrados na figura 6.15, clicando a
tecla B e arrastando uma janela sobre eles com o
botão esquerdo do mouse. Use a tecla B e depois
Shift mais o botão esquerdo do mouse para somar
vértices à seleção.

Agora faça uma extrusão (tecla E) com os vértices
escolhidos, ativando a opção Region, de modo a
conseguir uma forma como a da figura 6.16.

Fig. 6.13:
Escalamento
dos vértices.

Fig. 6.14:
Vertex Select
Mode.

Fig. 6.15:
Seleção de
vértices.

Fig. 6.16:
Vértices
extrudados
com opção
Region.
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Repita o procedimento mais uma vez para obter a for-
ma da figura 6.17.

Agora aperte a tecla G e movimente o mouse para
mover os vértices ainda selecionados, do modo a con-
seguir uma forma parecida com a da figura 6.18. Clique
com o botão esquerdo do mouse para fixar os vértices
na nova posição desejada.

Repita o procedimento de extrusão teclando E e esco-
lhendo a opção Region, de modo a conseguir algo como
a figura 6.19.

O apêndice criado, apesar de ainda não parecer, será
um dos tentáculos do polvo. Agora repita os procedi-
mentos anteriores para definir os outros tentáculos
(Figura 6.20).

Fig. 6.17:
Segunda
extrusão.

Fig. 6.18:
Movimentação
dos vértices.

Fig. 6.19:
Vértices
extrudados
com opção
Region

Fig. 6.20:
Modelagem
dos
tentáculos.
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 Uma vez definida a forma principal, seleci-
one os vértices centrais do objeto, clicando
em B e arrastando uma janela em torno dos
vértices desejados (Figura 6.21).

Passe agora para uma vista frontal (View, Front). Tecle a tecla O (a letra O, e não o
número zero) e surgirá um novo botão na barra de cabeçalho. Esse botão, quando
acionado, oferece uma lista de opções de Fallof. Fallof é a maneira como os pontos que
não estão selecionados seguirão as transformações dos pontos selecionados, depen-
dendo da sua distância até eles. Os ícones são auto-explicativos, experimente cada um
deles, mas para nosso exercício utilize a opção Sharp Fallof (Figura 6.22).

Pressione agora a tecla G, sem mover o
mouse. Veja que surge um círculo cinza que
envolve os vértices selecionados. Tecle Alt+
tecla de somar para aumentar o diâmetro
do círculo até envolver todos os vértices
do objeto (Figura 6.23). Este círculo defi-
ne quais vértices serão influenciados pelo
movimento dos vértices selecionados.

Fig. 6.21:
Vértices
centrais
selecionados.

Fig. 6.22:
Opções de
Fallof.

Fig. 6.23:
Influindo sobre
todos os
vértices do
objeto.
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Mova agora os vértices selecionados para
cima, como na figura 6.24 (Tecle G e mova
o mouse. Clique com o botão esquerdo do
mouse para fixar a posição).

A seguir, vamos definir a cabeça do polvo.
Selecione os vértices do topo da figura
(tecle B, clique e arraste uma janela) e faça
uma extrusão (tecle E, Only Edges) (Figura
6.25).

Agora faça uma operação de escalamento
aumentando a distância entre os vértices,
clicando S, movendo o mouse e clicando
com o botão esquerdo do mouse para fixar
a posição (Figura 6.26).

Faça mais duas extrusões e um escalamento
na última para diminuir a distância entre
os vértices. Depois realize mais uma últi-
ma extrusão e escalamento para que to-
dos os vértices se reúnam em um ponto
(Figura 6.27).

Fig. 6.24:
Movimentando
os vértices.

Fig. 6.25:
Extrusão dos
vértices
superiores.

Fig. 6.26:
Escalamento
dos vértices.

Fig. 6.27:
Fechamento
da cabeça do
polvo.
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Vá agora à aba Mesh Tools, do menu Edit, e aumente o valor
de Limit para 0,2, clicando depois em Rem Double (Remove
Double – Remover duplicatas). Esta operação irá remover os
pontos excedentes que se encontram muito próximos, dei-
xando apenas um único ponto no topo da cabeça do polvo. O
valor da variável Limit define a distância máxima em que os
vértices serão considerados como excedentes (Figura 6.28).

Selecione todos os vértices do objeto (tecle A) e clique no-
vamente em Rem Double. Agora todos os vértices exceden-
tes do objeto serão removidos, sendo sua quantidade
indicada pelo número que é mostrado após a palavra

Removed:.

Para usar o comando SubSurf  veja a figura
6.29. Basta selecionar o objeto e acionar o
botão SubSurf, escolhendo o número três para
o valor de Subdiv. O resultado deve aparecer
como na figura 6.30.

Agora acione o botão Set Smooth na aba Link
and Materials (Figura 6.31) e renderize a ima-
gem do modelo (F12).

Se a posição da câmera não for satisfatória
navegue na cena até encontrar uma posição
interessante, depois clique Ctrl+Alt+zero para
torná-la a vista da câmera (Figura 6.32).
Renderize novamente a imagem (F12).

Fig. 6.28:
Removendo
vértices
excedentes.

Fig. 6.30:
Polvo com
SubSurf
acionado.
Subdiv =
3.

Fig. 6.29:
Opção
SubSurf

Fig. 6.32:
Vista de
usuário
tornada
em vista
da câmera.

Fig. 6.31:
Opção Set
Smooth



COMPUTAÇÃO GRÁFICA
Secretaria de Estado de Educação MG

56

Ca
de

rn
os

 de
 In

for
m

áti
ca

Vamos agora assinalar a cor azul ao pol-
vo, da forma ensinada no módulo 7 (Figu-
ra 6.33).

Esse é um bom momento para se gravar o modelo construído até aqui, escolhendo File,
Save. Dê o nome Polvo.blend para o arquivo. Mais à frente ele será utilizado novamente
em outros exercícios.

Este exercício de modelagem levou à criação de um objeto orgânico relativamente com-
plexo, utilizando apenas formas geométricas básicas simples. Os princípios aprendidos
aqui podem e devem ser aplicados em qualquer situação onde os recursos do comando
SubSurf se mostrem úteis para a modelagem de objetos com superfícies curvilíneas
suaves.

Fig. 6.33:
Assinalando a
cor azul ao
polvo.
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MÓDULO 7:
MATERIAIS. APLICAÇÃO DE MATERIAIS. SMOOTH. UV MAPPING. WORLD. BACKGROUND.

7.1 MATERIAIS

Ao criarmos um objeto com o Blender, é necessário aplicar um material à sua superfície
para que ele se pareça da maneira como desejamos. Um objeto pode aparentar ser de
pedra, madeira, metal, água, fumaça ou qualquer outra coisa que quisermos, com grande
grau de realismo. Para que uma cena seja convincente, não basta ter os modelos
tridimensionais criados com o maior cuidado e detalhamento possível. Se não houver
uma escolha adequada das propriedades do material a ser aplicado, a aparência final do
objeto pode deixar muito a desejar.

Quando escolhemos as características de um material no Blender, podemos modificar a
sua cor e uma série de outros parâmetros relacionados à sua refletividade, transparência
e outras propriedades ópticas. Entretanto esses ajustes proporcionam a produção de
objetos homogêneos, lisos e uniformes. No mundo real os objetos possuem imperfeições,
irregularidades, sujidades e marcas de desgaste, que no Blender são simuladas através
do que é chamado de texturas. Devido ao caráter introdutório do nosso curso, não
entraremos no tema das texturas, devido à sua maior complexidade.

7.2 APLICAÇÃO DE MATERIAIS

Vamos criar uma cena simples para exercitar os recursos de aplicação de materiais. Crie
primeiro um plano (Add, Mesh>Plane) na vista de topo (View, Top). Agora vá para uma

vista de lado (View, Side) e duplique o plano (Alt+D) para
cima. Rotacione o plano duplicado em noventa graus
(tecle R e movimente o mouse com o botão Ctrl pressio-
nado até o giro chegar a 90 graus). Movimente o plano
girado alinhando-o com a quina do outro plano (tecle
G e movimente o mouse até o ponto desejado, depois
clique com o botão esquerdo para fixar a posição). O
objetivo é criar um piso encostado em uma parede, como
na figura 7.1.

Agora crie uma esfera UV com 32 segmentos e 32 anéis
(Add,Mesh>UVSphere). Faça uma operação de
escalamento (tecla S) e movimente a esfera (tecla G) de
modo a posicioná-la como na figura 7.2. Movimente a
luz e a câmera para iluminar apropriadamente a cena e
enquadrá-la em frente à câmera (veja o que a câmera está
vendo clicando a tecla zero). Quando a cena estiver
satisfatória, grave o arquivo (File, Save) com o nome
Cena1.blend. Mais à frente iremos utilizar esse arquivo
novamente.

Fig. 7.1:
Planos
perpendiculares.

Fig. 7.2:
Planos com
esfera.
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Para se aplicar um material em um objeto selecionado, escolha o objeto desejado, no
caso a esfera, e tecle F5, ou clique no botão que mostra uma pequena esfera no cabeçalho
da janela de botões. Depois escolha a opção Add New na aba Material. A janela que
surge a seguir contém diversas opções para controle dos parâmetros do material desejado
(Figura 7.3).

A cor do material pode ser escolhida ajustando-se os controles deslizantes que mistu-
ram as cores básicas vermelho (Red), verde (Green) e azul (Blue), como pode ser visto
na figura a seguir (Figura 7.4). A janela à esquerda da figura mostra um exemplo do
material que está sendo criado. A coluna de botões enfileirados verticalmente ao lado
direito da esfera vermelha da figura 7.4 oferece opções de visualização do exemplo do
material. O primeiro mostra o material aplicado sobre um plano, o seguinte sobre uma
esfera, e o terceiro sobre um cubo. O botão isolado seguinte muda o padrão do fundo,
para verificação do índice de transparência e os dois últimos acendem ou apagam duas
luzes que iluminam o exemplo.

Mexendo nos botões deslizantes R, G e B da opção Col (Color) podemos ajustar a cor
desejada do objeto (Figura 7.5).

Já o botão deslizante A (Alpha), abaixo dos controles
de cor, varia o índice de transparência do material. Aten-
ção! Para que a transparência se efetive é preciso que o
botão ZTransp, na aba Mirror Transp esteja acio-
nado. O efeito de transparência só poderá ser apreci-
ado na janela de renderização, clicando-se F12 (Figura
7.6).

Fig. 7.3:
Criação de um
novo material.

Fig. 7.4:
Controles RGB.

Fig. 7.5:
Mudando as
cores –
vermelho,
verde e azul.

Fig. 7.6:
Efeito de
transparência.



Ca
de

rn
os

 de
 In

for
m

áti
ca

59

COMPUTAÇÃO GRÁFICA
Secretaria de Estado de Educação MG

Fig. 7.7: Objeto
renderizado no
modo Solid.

Fig. 7.8:
Botão Set
Smooth para
suavização da
superfície dos
objetos na
renderização.

Fig. 7.9:
Objeto
renderizado
no modo
Smooth.

7.3. CORES

Devido a questões técnicas que no momento não vêm ao caso, a dinâmica das cores no
vídeo é menor do que no monitor do computador. Isto significa que nem todas as cores
geradas pelo computador e vistas no seu monitor podem ser mostradas corretamente
no vídeo. O melhor a se fazer, então, é manter a maioria das cores presentes na cena o
menos saturada quanto for possível, isto é, evitando os valores máximos de R (Red –
Vermelho), G (Green – Verde) e B (Blue – Azul). Uma boa regra é manter a diferença
entre o maior e o menor valor RGB das cores em, no máximo, 200, levando-se em
consideração uma faixa de 0 a 255.

7.4. SMOOTH

Quando criamos um objeto e assinalamos uma cor a
ele, podemos renderizar a imagem e verificar que ele
aparece facetado, mostrando todas as faces de que é
construído (Figura 7.7).

Para suavizar a superfície do objeto desejado, sem
aumentar a complexidade da sua estrutura, basta se-
lecionar o objeto, entrar no modo de edição (tecla
Tab) e clicar no botão Set Smooth, embaixo à esquer-
da da aba Link and Materials (Figura 7.8). A ativação

deste recurso não modifica nada na geometria do objeto, apenas muda a maneira como
é calculado o sombreamento das superfícies, dando a aparência de uma superfície mais
lisa e suave (Figura 7.9).

Se for necessário pode-se clicar novamente no botão
Set Solid para voltar à condição anterior.

Crie uma esfera UV com 16 segmentos e 16 anéis (Add,
Mesh>UVSphere). Uma demonstração clara de que a
operação de smooth não modifica a geometria do
objeto pode ser vista nas figuras 7.10 e 7.11. Na figu-
ra 7.10, uma esfera UV com 16 segmentos e 16 anéis
foi renderizada sem o efeito smooth. Na figura 7.11 a
mesma esfera é renderizada com o efeito Smooth. Veja
como a curvatura da esfera continua facetada. Isto se
deve ao fato de que o efeito smooth afeta apenas as
cores dos pixels das faces do objeto, não mudando
em nada os 16 segmentos e os 16 anéis da estrutura
da esfera. Experimente renderizar a esfera que você
criou no modo Solid e no modo Smooth.

Fig. 7.11
Renderização
com smooth.

Fig. 7.10
Renderização
sem smooth.
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7.5 BACKGROUND

Além das cores dos objetos, devemos também levar em consideração a cor do fundo e
da luz ambiente. Clicando-se no botão World (Figura 7.12) no cabeçalho da janela de
botões, surgem controles que permitem alterar estes parâmetros, além de outros. Na
figura 7.13 podemos ver os controles deslizantes destacados em vermelho, que permi-
tem determinar a cor do fundo.

Os três controles da esquerda, denominados HoR, HoG e HoB, irão escolher a cor do
horizonte, ou da parte inferior da tela. Os controles à direita, ZeR, ZeG e ZeB, são utili-
zados para a cor do zênite, ou da parte superior da tela. Quando o botão Blend, à
esquerda desse conjunto, está acionado, são utilizadas duas cores para o mundo. Blend
efetua uma gradação suave entre a cor do horizonte, determinada pelos botões Ho, e a
cor do zênite, escolhida pelos botões Ze. Se apenas esse botão estiver selecionado, essa
gradação será de baixo para cima, independentemente da orientação da câmera. O bo-
tão Paper posiciona o horizonte no meio da tela, independentemente da posição da
câmera. O botão Real é usado para reposicionar a linha do horizonte de acordo com a
localização da câmera. Às vezes esse efeito se comporta de forma inconsistente no
Blender. Se nenhum desses três botões estiver habilitado, o fundo da tela terá a cor
plana, determinada por HoR, HoG e HoB.

Os botões deslizantes logo abaixo, nomeados AmbR, AmbG e AmbB controlam a cor da
luz ambiente. Esta luz, quando ativada, banha toda a cena com uma luz difusa
omnidirecional (Figura 7.14).

Nós podemos também utilizar uma imagem digital
qualquer para aparecer no fundo da cena. Para isso
basta acionar o menu View, no cabeçalho da janela
3D, e clicar na opção Background.

Ao fazer isso surge uma pequena janela intitulada
Background Image, que possibilita a escolha de uma
imagem para ser utilizada como fundo (Figura 7.15).
Acione o botão Use Background Image e surgirão uma

série de opções. O botão Image serve para escolher o arquivo de imagem que será
utilizado. Para ter o resultado visto na imagem abaixo, crie primeiro uma icosfera com
duas subdivisões (Add, Mesh>Icosphere). Depois localize e escolha a imagem
Eletricidade.jpg (fornecida no CD que acompanha o livro). O botão deslizante Blend

Fig. 7.12:
Botão World.

Fig. 7.13:
Controles de cor
do fundo.

Fig. 7.14:
Controles da
luz ambiente.
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Fig. 7.15:
Imagem em
Background.

Fig. 7.16:
Ativação do
modo de
seleção de
faces UV.

Fig. 7.17:
Divisão de
janela.

controla a transparência da imagem. O
parâmetro Size modifica o tamanho da imagem.
Os parâmetros X Offset e Y Offset deslocam a
imagem na horizontal ou na vertical. Essa pe-
quena janela pode ser minimizada ou fechada
como uma janela normal de programa.

Atenção: O Background é visível apenas nas vistas padrão (Top, Front, Side, Camera).

7.6. UV MAPPING

Quando queremos que nossos objetos virtuais se assemelhem a algum material conhe-
cido, podemos aplicar uma imagem digital desse material sobre a superfície daquele
objeto. O UV Mapping é um recurso desenvolvido com o objetivo de se determinar onde
localizar, na superfície de um objeto, todos os pixels, ou pontos da imagem digital que
queremos utilizar como uma textura. Normalmente os pixels são associados aos vértices
dos objetos, mas como geralmente há muito mais deles na imagem que queremos utili-
zar do que vértices no modelo, o Blender efetua uma operação de interpolação para
escolher a localização dos pixels entre os vértices do objeto. O UV Mapping difere dos
outros meios de aplicação de materiais, tais como a janela de materiais (F5) e de textu-
ra (F6), porque ele não usa simplesmente uma projeção sobre o objeto, mas realmente
adere à superfície escolhida, e é distorcido junto com ela. Tecnicamente falando, o
processo de UV Mapping consiste em assinalar coordenadas bidimensionais aos vérti-
ces do objeto, nomeadas por convenção de ‘u’ e ‘v’, e associando estas com as coorde-
nadas ‘x’ e ‘y’ dos pixels da imagem utilizada.

Siga a seguinte seqüência para compreender como o processo fun-
ciona:

• Crie um cubo. (Space, add > mesh > cube);

• No Header da janela 3D ative a opção UV Face Select. A aplicação
de materiais UV é sempre feita dessa forma (Figura 7.16);

• Divida a janela em duas no sentido vertical (Clique com o botão
direito na linha da janela e confirme a opção Split area) (Figura
7.17);
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Fig. 7.18:
Janela UV/
Image Editor.

Fig. 7.19:
Face do cubo
selecionada.

Fig. 7.20:
Imagens para
ser usadas na
aplicação de
material UV.

Fig. 7.21:
Opção de
atualização
automática.

• Mude uma das vistas para a janela UV Image Editor (Figura 7.18);

• Selecione a janela do cubo clicando nela e clique a tecla A para
garantir que não há nada selecionado nela. Selecione uma face do
cubo clicando nela com o botão direito do mouse. Gire o objeto
para se certificar que há apenas uma face escolhida (Figura 7.19);

• Iremos utilizar seis imagens prepara-
das para este tutorial, intituladas UV1
a UV6. Todas são no formato .jpg e
podem ser acessadas no CD que acom-
panha o curso (Figura 7.20).

• Localize e carregue a primei-
ra imagem (UV1.jpg) na jane-
la de imagem (Image > Open).
Habilite a opção Update
automatically para ver o obje-
to com a imagem aplicada na
face escolhida do objeto em
tempo real (Figura 7.21). A
mesma opção pode ser esco-
lhida clicando-se no botão
com forma de cadeado no can-

to inferior direito da janela de imagem. Imediatamente a face selecionada
do cubo mostrará a imagem aplicada sobre ele na janela 3D (Figura 7.22);
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Fig. 7.23:
Imagens
aplicadas em
todas as faces
do cubo.

Fig. 7.22:
Imagem na face
selecionada do
cubo.

• Pode ser que a orientação da imagem
não esteja na posição desejada. Nesse caso
a imagem pode ser rotacionada para que
fique na orientação correta. Clique na ja-
nela 3D, selecione a face que está com a
imagem que deseja rotacionar, certifique-
se que está no modo de visualização UV
Face Select, e clique a tecla R. Confirme a
opção UV Co-ordinates. Cada vez a opção
for confirmada, a imagem irá girar 90
graus (Figura 7.22);

• Repita o procedimento para as outras fa-
ces do cubo, utilizando as imagens UV2 a
UV6.jpg. No final ele deverá aparecer como
na figura 7.23. Dê uma volta em torno do
cubo para visualizar as faces de trás (te-
clas 4, 6, 8 e 2).
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MÓDULO 8:
LUZES E CÂMERAS. ILUMINAÇÃO DE CENA. TIPOS DE LUZES. POSICIONAMENTO E MANIPULAÇÃO DE
CÂMERAS. RENDERIZAÇÃO STILL FRAME. FORMATOS DE SAÍDA.

8.1. LUZES E CÂMERAS.

A iluminação é uma das etapas mais importantes de uma animação. Mesmo que os
objetos da cena estejam devidamente modelados e com suas cores e texturas determi-
nadas, torna-se necessário ajustar a posição, a intensidade, o número, o tipo, a movi-
mentação e a cor das luzes que irão constituir a cena. Essa escolha irá levar em conta o
clima da cena, a natureza dos objetos, a hora do dia em que a ação virtual está aconte-
cendo, os destaques que se quer dar na cena e o grau de realismo ou o efeito que se
deseja alcançar. Ainda que as etapas de modelagem e aplicação de texturas tenham sido
realizadas com cuidado, o resultado pode ser péssimo se não houver cuidado com a
iluminação. Por outro lado, até mesmo um objeto simples pode ter uma aparência rea-
listicamente convincente se for iluminado de forma apropriada.

8.2 ILUMINAÇÃO DE CENA.

Aos iniciantes é comum a idéia de que uma única fonte de luz possa ser suficiente para
iluminar adequadamente uma cena. Esta idéia não corresponde à realidade, pois no
mundo real a luz é refletida, difratada e transmitida, suavizando sombras e criando
brilhos específicos. Para que uma cena seja adequadamente iluminada, é comum a uti-
lização de várias luzes com características diferentes, ajustadas para as funções deseja-
das. Toda a física das interações da luz com as superfícies da cena pode ser simulada
pelo renderizador Ray Tracing e também pelo algoritmo Radiosity, ambos internos ao
Blender, mas bem mais lentos de ser calculados do que o processo padrão, que é um
renderizador de varredura, mais rápido. Este algoritmo consegue ser mais rápido por-
que ele não tenta simular o comportamento real da luz, mas assume várias hipóteses
simplificadoras. Mesmo assim seus resultados finais são bastante aceitáveis. Neste cur-
so não iremos abordar os recursos de Ray Tracing e Radiosity, que ficarão reservados
para um módulo mais avançado.

8.3 TIPOS DE LUZES

O Blender nos oferece cinco tipos diferentes de luzes: Lamp, Sun, Spot, Hemi e Area.
Cada uma dessas luzes possui características próprias que as tornarão mais adequadas
para diferentes tipos de aplicação. Iremos avaliar seus pontos fortes e fracos e sugerir
a utilização mais apropriada para cada uma delas.

Abra o arquivo Cena1.blend, que foi criado em um exercício anterior. Adicione à cena
uma icosfera com uma subdivisão (Add, Mesh>Icosphere) e um cilindro (Add,
Mesh>Cylinder). Movimente-os e assinale cores a estes objetos, como aprendido anteri-
ormente, de modo a deixar a cena como na figura 8.3. Agora vamos testar os tipos de
luzes oferecidas pelo programa.
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Fig. 8.1:
Tipos de
luzes -
criação.

Fig. 8.2:
Opções de
tipos de
luzes.

Fig. 8.3:
Luz Lamp.

Fig. 8.4:
Luz Sun.

Quando criamos uma nova luz (Add, Lamp>...) temos acesso
a uma lista de tipos de luzes que podemos utilizar em nos-
sas cenas (Figura 8.1).

Também podemos transformar um tipo de luz em outro, se-
lecionando a luz desejada e clicando no botão Shading do
cabeçalho da janela de botões, e escolhendo a opção do
tipo de luz na aba Preview (Figura 8.2).

Lamp: A luz do tipo Lamp é uma luz pontual e
omnidirecional, que funciona como um ponto
irradiando a mesma quantidade de luz em to-
das as direções. Na janela 3D, essa luz é repre-
sentada por um ponto e um círculo amarelo.
Como se fosse uma luz emitida por uma lâm-
pada, sua intensidade irá diminuir na razão
do inverso do quadrado da distância ao obje-
to. É um bom tipo de luz para realçar brilhos
pontuais em objetos (Figura 8.3).

Sun: A luz do tipo Sun procura imitar a luz do
Sol, vindo de uma direção constante com in-
tensidade uniforme e não projeta sombras. É
importante compreender que no Blender, devi-
do a limites dos algoritmos de renderização,
somente a luz do tipo Spot projeta sombras no
renderizador padrão. Nenhum outro tipo de luz
é capaz de projetar sombras, a não ser utilizan-
do-se do Ray Tracing. A luz tipo Sun é definida
por sua energia, sua cor e sua direção, sendo
que sua localização não é importante (Figura
8.4).

Spot: Esta é a luz mais utilizada no Blender,
devido ao fato de ser a única capaz de proje-
tar sombras no renderizador padrão. É tam-
bém a mais complexa de ser utilizada. Uma
luz do tipo Spot projeta um cone de luz gera-
do a partir da localização da fonte luminosa,
que fica no vértice do cone, e a emite em uma
dada direção (Figura 8.5).Fig. 8.5:

Luz Spot.
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A complexidade da luz Spot envolve uma série de
parâmetros adicionais que se revelam na aba Shadow and
Spot, do botão Shading no cabeçalho da janela de botões
(Figura 8.6). Os botões são:

Ray Shadows: Habilita o renderizador Ray Tracing.

Buffer Shadows: Usa o renderizador padrão.

Only Shadow: Esta opção faz com que a luz Spot apenas projete a sombra do objeto,
sem iluminá-lo.

Square: Ao invés de um cone de luz, esta opção projeta uma pirâmide de luz, iluminan-
do uma área com seção quadrada.

Halo: Faz com que a luz Spot projete um halo difuso, como se os raios de luz tivessem
passado através de um meio enevoado.

Os parâmetros que admitem valores numéricos são:

SpotSi: O ângulo de abertura do cone de luz.

SpotBl: A transição entre o cone de luz e a área escura circundante. Se o valor for
pequeno, a borda será bem contrastada, se o valor for grande, a borda será suavizada.
Esta característica se aplica apenas às bordas do cone da luz spot, e não às suavidade
das sombras projetadas pelos objetos iluminados pela luz.

HaloInt:  Se o botão Halo estiver habilitado, este valor numérico define a intensidade
do halo da luz Spot.

Hemi: Este é um tipo especial de luz, que
tenta simular a luz vinda de um céu nublado
e uniforme. Ela pode ser vista como uma
luz emitida por um hemisfério irradiante
que cobre toda a cena. A luz do tipo Hemi
possui poucos parâmetros de utilização,
que se assemelham aos da luz tipo Sun.
Entretanto, ela consegue resultados mais
suaves e difusos do que a luz Sun. A sua
localização não é importante, mas a sua
orientação sim (Figura 8.7). A linha ponti-

lhada que aparece saindo da lâmpada mostra a direção em que a máxima energia é
irradiada. Não projeta sombras em nenhuma circunstância.

Fig. 8.6:
Menu da luz
tipo Spot.

Fig. 8.7: Luz
Hemi.
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Area: A principal aplicação da luz do tipo
Area é para se conseguir sombreamentos
com bordas suaves e difusas. Ela também
é utilizada para simular ambientes
normalmente iluminados com luz difusa,
tais como shopping centers, ou para uma
iluminação externa nublada (Figura 8.8).

8.4 POSICIONAMENTO E MANIPULAÇÃO DE CÂMERAS.

Um vídeo ou um filme sempre são realizados com o auxílio de câmeras. Elas são o
instrumento de registro da imagem daquilo que será animado, e é o seu ponto de vista
que determina o que será visto pelo espectador. No computador, a imagem da câmera é
utilizada para se dar o ponto de vista que você deseja que apareça na animação ou na
renderização de um quadro fixo. Na janela 3D, tecle a tecla zero do teclado numérico,
para mudar a vista da janela para a vista da câmera.

A câmera é considerada pelo Blender apenas como mais um objeto da cena. Ela pode ser
selecionada com um clique do botão direito do mouse e movida com o auxílio da tecla
G ou rotacionada com o auxílio da tecla R. Movendo e rotacionando a câmera nós
podemos escolher o ponto de vista a ser mostrado pela animação. Alternando entre a
visão da câmera e outra vista fica fácil posicionar a câmera de acordo com o resultado
planejado.

Para acessar as propriedades da câmera, crie uma câmera ou selecione a câmera desejada
e tecle F9 ou clique no botão Editing (Figura 8.9) no cabeçalho da janela de botões. As
opções que temos nos permite um amplo controle sobre vários parâmetros que
caracterizam a câmera. Tecle no botão Lens (Lente) e altere o valor de 35 para 80.
Observe a vista da câmera clicando zero no teclado numérico e veja como a imagem do
objeto aparece mais próxima. Através deste artifício é possível efetuar um zoom, apro-

ximando a imagem de um objeto sem a
necessidade de mover, nem a câmera,
nem o objeto. Valores menores na lente
nos dão uma visão mais ampla da cena,
mas valores muito pequenos podem
distorcer a imagem de objetos próximos.

Outros botões de controle são o ClipSta e o ClipEnd. Quando uma cena se torna muito
ampla, com objetos a grande distância, pode acontecer que não queiramos renderizar
esses objetos a partir de uma determinada distância. Essa distância é determinada pelo
valor de ClipEnd. Qualquer objeto que estiver além da distância escolhida em ClipEnd
não aparecerá na renderização. Já o botão ClipSta marca o ponto a partir do qual serão
renderizados os objetos. Qualquer objeto localizado antes desse ponto não aparecerá,
ou aparecerá truncado na renderização. Os únicos objetos da cena que aparecerão na

Fig. 8.8: Luz
Area.

Fig. 8.9:
Parâmetros de
controle da
câmera.
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renderização serão aqueles localizados
entre os limites de ClipSta e ClipEnd da
câmera. Para visualizar melhor esses limi-
tes, ative a opção ShowLimits. Aparecerá
uma linha que sai da câmera que mostra
exatamente a posição de ClipSta e ClipEnd
em relação à câmera e aos objetos da cena
(Figura 8.10).

O valor de DrawSize muda o tamanho do
ícone da câmera (Figura 8.11). Isto é útil
quando estamos trabalhando com uma
cena muito grande, onde o ícone da câmera
fica muito pequeno e difícil de encontrar
no meio de outros objetos. Já o botão Orto
muda a vista da câmera de perspectiva
para ortográfica e vice-versa (Figura 8.12).

Vista em perspectiva.  Vista isométrica ou ortográfica.
Fig. 8.12

Caso se queira mudar de ponto de vista rapidamente durante uma animação, é possível
criar várias câmeras na mesma cena e alternar as suas vistas no decorrer da animação.
Para se criar uma nova câmera basta escolher a sua posição com o cursor, clicar a barra
de espaços e escolher Add>Camera. Uma nova câmera será criada no local onde o cursor
se encontrava.

Mesmo quando temos muitas câmeras na cena, o Blender renderiza sempre o ponto de
vista da primeira delas. Se quisermos observar o ponto de vista de uma determinada
câmera dentre muitas, basta selecioná-la e clicar Ctrl + zero no teclado numérico. A
janela 3D irá mostrar a vista daquela câmera. Mas ao clicar F12, só veremos a renderização
da vista escolhida se acionarmos o botão Lock na parte inferior à direita da janela 3D

Fig. 8.10:
Show Limits.

Fig. 8.11:
Drawsize = 1.
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(Figura 8.13). Com esse botão
ativado, o Blender irá renderizar
sempre a imagem da vista da
câmera escolhida.

Crie algumas câmeras e exercite
o que aprendeu até agora, mu-
dando os pontos de vista e os
valores das variáveis das câmeras.
Compare os resultados.

8.5 RENDERIZAÇÃO STILL FRAME

Muitas vezes é necessário
renderizar um quadro fixo (still
frame) de uma cena para se confe-
rir se tudo está de acordo com o
desejado. Ao fazê-lo, podemos ve-
rificar se os materiais estão bem de-
finidos, se a iluminação está valo-
rizando os pontos corretos da
cena, se as sombras estão convin-
centes, se o enquadramento está
bom, e assim por diante. Este re-
curso é muito utilizado no decor-
rer de um projeto de animação, to-
das as vezes que precisamos con-
ferir pontos específicos do seu de-
senvolvimento.

Às vezes a renderização de um qua-
dro fixo é o objetivo principal do
trabalho. Podemos imaginar, por
exemplo, um projeto de design in-
dustrial mostrando como seria a
aparência de um produto, mostra-
do em imagens impressas. Ou uma

proposta de uma escultura em praça pública, mostrando uma composição digital feita
em computação gráfica, unindo uma foto da praça e uma imagem renderizada em 3D da
escultura. Veja o grau de sofisticação que uma imagem 3D gerada pelo Blender pode
alcançar na figura 8.14.

Fig. 8.13:
Botão Lock.

Fig. 8.14:
Renderização
Still Frame -
Piano Corner -
Zsolt Stefan.
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Para que o Blender renderize uma imagem
daquilo que a câmera selecionada está ven-
do, basta teclar F12. Uma janela irá se abrir,
mostrando o progresso da operação de
renderização. A gravação desta imagem
renderizada no disco não é automática,
sendo necessário clicar a tecla F3 para abrir
a janela de diálogo para a gravação do
arquivo. Enquanto isso a imagem
renderizada fica armazenada na memória.
Atenção! O Blender não coloca a extensão

do arquivo automaticamente nos arquivos de imagem (.jpg, .tga, etc.), isso deve ser
feito à mão, na janela de diálogo, e a extensão digitada deve ser a mesma que foi
escolhida no painel de renderização, para que não haja conflitos na hora da leitura do
arquivo. Mais à frente serão dadas explicações sobre cada um dos formatos dos arqui-
vos de saída.

Carregue o arquivo Polvo.blend, criado no módulo 6 (File, Open), e faça uma renderização
Still Frame, como na figura 8.15.

Fig. 8.15:
Renderização
Still Frame.
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MÓDULO 9:
ANIMAÇÃO BÁSICA – FATORES DE TEMPO,  MÉTODOS DE ANIMAÇÃO – KEY FRAMES,
MOTION CURVES, PATHS.

9.1 ANIMAÇÃO BÁSICA.

O fenômeno fundamental que possibilita a ilusão de uma imagem em movimento em
um vídeo, filme ou animação é o da persistência retiniana. Nossa retina leva alguns
décimos de segundo para perceber a mudança entre duas imagens fixas sucessivas. Se
mostrarmos uma série de imagens se sucedendo a uma freqüência maior do que 24
quadros por segundo, nosso cérebro interpreta essa seqüência como uma imagem em
movimento contínuo, por não ser capaz de separar as imagens fixas com rapidez
suficiente.

Em uma animação computacional são calculadas várias imagens fixas, com pequenas
variações sucessivas de uma cena em transformação, normalmente gerando-se 30
imagens para cada segundo de animação. Para um minuto de animação precisaríamos
então de 1800 imagens, o que explica o grande espaço de armazenamento necessário
para animações mais longas. A enorme quantidade de cálculos feitos para se renderizar
a animação é a principal razão desta etapa ser a mais computacionalmente custosa e
demorada, mas o processo é totalmente automático. Uma vez que todos os parâmetros
estejam de acordo com o planejado, basta apertar um botão para iniciar o processo de
renderização. As cenas serão individualmente renderizadas e gravadas em um arquivo
previamente escolhido de acordo com o formato desejado de saída.

No Blender podemos animar quaisquer objetos pertencentes à cena, incluindo aí as
luzes, e também a câmera. Então temos total liberdade de direção, podendo estabelecer
movimentos de câmera (alguns impossíveis de serem efetuados na realidade), mudanças
de iluminação ou sincronização de movimentos de objetos da cena.

9.2 FATORES DE TEMPO

A qualidade de uma animação depende de vários fatores envolvidos, tais como a resolução
de saída, o número de quadros por segundo, o tipo de arquivo de saída e a compressão
utilizada. Em uma animação nós precisamos determinar antecipadamente qual será a
duração da mesma em segundos, e qual a taxa de quadros por segundo (fps – frames
per second) que será escolhida. Esta taxa depende da utilização desejada para a anima-
ção. Se a animação for feita para ser mostrada através da Internet pode-se reduzir a
taxa para 15 fps, que é o suficiente para garantir transições relativamente suaves, ao
mesmo tempo que garantem um tamanho de arquivo mais reduzido e tempos de download
mais curtos. As taxas mais utilizadas, em quadros por segundo, são:

NTSC – Padrão norte-americano e japonês de vídeo: 30 fps

Film – Padrão de filmes para cinema: 24 fps

PAL – Padrão europeu de vídeo: 25 fps

Custom – Padrão escolhido pelo usuário
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9.3 MÉTODOS DE ANIMAÇÃO

Existe uma série de maneiras de se animar um objeto. Podemos animar objetos através
da mudança da sua posição, orientação ou tamanho. Também é possível animá-los por
meio de deformações ou animando seus vértices ou pontos de controle. Por último é
possível animar objetos a partir de uma interação bastante complexa e flexível com um
tipo especial de objeto chamado Armature ou Armadura. Não apresentaremos o tópico
Armature nesse texto, devido à nossa abordagem introdutória.

Existem três métodos que são mais utilizados em programas de animação 3D para se
conseguir animar um objeto:

• Key frames (Quadros-chave) – A animação é criada através da interpolação das posi-
ções, ou de outro parâmetro animável, entre os objetos pertencentes a dois quadros
(frames) escolhidos da animação. O animador pode trabalhar visualizando claramente
as unidades escolhidas, saltando de um keyframe para o seguinte, e pode também
mudar posições criadas anteriormente ou movê-las no tempo.

• Motion Curves (Curvas de Movimento) – Podemos desenhar curvas representando a
condição de cada componente XYZ para localização, rotação e tamanho. A forma desses
gráficos para o movimento pode ser ajustada horizontalmente para o tempo e
verticalmente para os valores desejados. Este método apresenta a vantagem de nos dar
um controle preciso sobre os resultados do movimento.

• Path (Caminho) – Um path é uma curva desenhada no espaço tridimensional, cuja
forma irá determinar o caminho que um objeto será obrigado a seguir na animação, de
acordo com uma função de tempo distribuída ao longo desse caminho.

O programa Blender integra os dois primeiros métodos em um único, chamado de siste-
ma IPO (InterPOlation - Interpolação) . Basicamente podemos dizer que o sistema IPO
consiste de curvas de movimento padrão. Se quisermos trabalhar no modo keyframe,
basta apertar um botão para alternar os métodos sem que os resultados sejam alterados.
De acordo com as preferências do usuário, pode-se alternar entre os dois métodos de
animação de modo a se conseguir o melhor resultado desejado.

9.4 KEY FRAMES

Quando usamos o método keyframe, os quadros-chave são criados no início e no fim de
qualquer movimento, mudança de escala ou rotação de um objeto. Tendo determinado
o tempo necessário para a transição desejada, devemos calcular o número de quadros
entre os key frames, dependendo do número de quadros por segundo escolhidos para
o formato de saída. Por exemplo, se queremos que um objeto se mova do ponto A para
o ponto B em 2 segundos e nós escolhemos uma taxa de saída de 30 quadros por
segundo (padrão NTSC), então deverão existir 60 quadros entre o keyframe inicial e o
final. Toda diferença que existir entre um keyframe e outro será interpolada quadro a
quadro.

Para um exemplo simples de como a animação de um objeto pode ser feita com este
método, vamos utilizar o polvo que foi criado no exercício do módulo 6. Carregue o
arquivo Polvo.blend (File, Open). Vá até a janela que marca o quadro atual da animação
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(Figura 9.1, marcada em vermelho) e
coloque-a no número 1. Selecione o
polvo e tecle a tecla I. No menu que
aparece a seguir, escolha a opção Rot.
Esta opção marca a posição rotacional
em que o polvo estará nesse keyframe
em particular (Figura 9.1).

Agora mude o número do quadro atual da animação atra-
vés das teclas de cursor ou utilizando o mouse, para o
número 60 (Figura 9.2).

Tecle N e mude o número de RotZ para 360 (clique
Shift+botão esquerdo do mouse no local do valor numé-
rico para editá-lo) (Figura 9.3). Tecle I e clique em LocRot,
informando ao programa o grau de rotação desejado até
aquele quadro. O que nós fizemos foi dizer ao programa
que queremos que o polvo esteja em uma determinada
posição no quadro um, e que ele gire 360 graus no eixo
Z nos 60 quadros seguintes. Para visualizar a animação

volte para o quadro 1 e pressione as teclas Alt+A, e para interrompê-la tecle Escape.
Note como o cursor mostra o número do quadro que está sendo mostrado naquele
instante.

Se quisermos tornar a visualização da animação cíclica, precisamos dizer ao Blender
qual o número de quadros que animação possui no total. Clique no botão Scene, no
cabeçalho da janela de botões e observe a aba Anim. Na parte inferior há dois números,
Sta e End (Figura 9.4). Esses valores determinam o tamanho da animação a ser visualizada.
Como no nosso exemplo a animação possui 60 quadros, basta colocar esse valor na
variável End e digitar Alt+A para ver a animação retornar ao início indefinidamente. Se
seu computador é lento, utilize o modo de visualização Wireframe para a janela 3D.

Vamos agora renderizar essa pequena animação em um formato de pré-visualização. Na
aba Format, clique na opção Preview. Depois clique no grande botão Anim, na aba Anim.
Isso irá iniciar o processo de renderização da animação, quadro a quadro. O resultado
final pode ser visto clicando-se no botão Play.

Fig. 9.1:
Marcação de
um keyframe.

Fig. 9.2:
Estabelecendo
o número de
quadros de
uma
animação.

Fig. 9.3:
Definição da
rotação do
objeto no
eixo Z.

Fig. 9.4:
Animação cíclica –
determinação do
número total de
frames a ser
animados.
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9.5 MOTION CURVES

O método IPO é universal no Blender, podendo controlar qualquer parâmetro animável,
desde o movimento de um objeto, até as características de um material. Cada bloco IPO
possui um número fixo de canais disponíveis, onde cada um possui um nome que indica
como ele será aplicado. Ao adicionar uma curva IPO a um canal, o processo de animação
é automaticamente iniciado. Curvas podem ser diretamente ligadas a um valor ou a uma
variação dele. Essa última opção permite mover objetos sem perturbar seu sistema IPO,
fazendo com que sua localização real seja determinada pelas curvas IPO relativamente
ao ponto onde se encontra.

Vamos utilizar a animação simples feita na seção anterior para
visualizar a sua curva de movimento. Primeiro divida a janela
3D em duas (clique com o botão direito do mouse na borda da
janela e confirme Split). Depois torne a janela da direita uma
janela IPO Curve Editor (Figura 9.5).

Em seguida clique com o botão es-
querdo do mouse na variável RotZ e
clique algumas vezes a tecla menos do
teclado numérico para tornar todo o
gráfico visível. Você pode também
usar Alt+botão esquerdo do mouse
para fazer uma panorâmica na janela
IPO. As janelas deverão aparecer como
na figura 9.6.

O que a janela da direita está mostrando é uma curva que representa o giro assinalado ao
polvo da janela esquerda, ao longo dos quadros da animação. Clique com o botão esquer-
do do mouse sobre a curva e arraste para ver a posição do polvo em cada quadro da
animação. Os números na horizontal do gráfico são os quadros da animação, e os núme-
ros na vertical mostram os valores da rotação desejada, neste caso, a rotação no eixo Z.

As curvas de movimento são um método extremamente poderoso de animação, permi-
tindo a edição de efeitos dinâmicos sutis e complexos. Através da modificação da forma
das curvas e da marcação de quadros-chave é possível se conseguir controle sobre
todos os movimentos dos objetos da cena, iluminação, câmeras e materiais. Entretanto
sua utilização eficiente depende de uma grande intimidade com seus recursos e possi-
bilidades.

Fig. 9.5:
Janela Ipo
Curve Editor.

Fig. 9.6:
Janela
dividida.
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Fig. 9.7: Pontos
de controle na
curva IPO.

Fig. 9.8:
Criação de um
path.

Fig. 9.9: Path.

Apenas a título ilustrativo, vamos manipular a curva que controla a rotação do polvo.
Primeiro selecione a curva clicando nela com o botão direito do mouse. Depois clique S
para fazer uma operação de escalamento com a curva e movimente o mouse. Veja que a
operação de escalamento modifica a quantidade de rotação aplicada ao objeto. Tecle
Escape para cancelar a mudança. Agora, com a curva ainda selecionada, tecle G e movi-
mente o mouse. Agora a curva é movimentada no sentido horizontal, permitindo a

movimentação da animação inteira no tempo.

As curvas IPO também podem ser manipuladas no
modo de edição. Para isso tecle Tab, e verá que sur-
gem pontos de controle nos vértices da curva IPO
(Figura 9.7).

Estes pontos de controle permitem ajustar a forma
da curva IPO mais ou menos como uma curva Bézier,
que determinará por sua vez se o movimento será
fluido, constante, periódico ou irregular. Experimen-
te com algumas variações e verifique o resultado
na animação.

9.6 PATHS

Muitas vezes é necessário fazer um objeto se movimentar ao longo de um percurso
difícil de ser determinado através dos métodos anteriores. Animar um planeta em órbi-
ta elíptica pode ser quase impossível de ser feito utilizando-se de keyframes, mas é
relativamente fácil de se fazer com o auxílio de paths. Outra utilidade deste recurso é a
possibilidade de utilização de uma linha para determinar um movimento de câmera
mais complexo no espaço. Um path é uma linha construída no espaço tridimensional
que serve de guia para o movimento de um objeto (objeto, câmera ou luz). Ao ligarmos
um objeto com um path, nós determinamos exatamente o movimento que ele terá que
seguir. Vamos utilizar o arquivo Polvo.blend, criado no módulo 6, para este exercício.
Carregue-o primeiro (File, Open).

Agora é preciso criar o path. Para isso clique Space,
Add, Curve>Path (Figura 9.8), na vista de topo.

Surgirá uma linha Bézier amarela subdividida por vá-
rios traços verticais negros e marcada por pontos ama-
relos (Figura 9.9). Os traços negros ao longo da linha
representam o número de quadros utilizados para o
movimento ao longo da curva, que por padrão é defi-
nido em 100, mas pode ser modificado. Os pontos
amarelos são pontos de controle de uma curva. Sele-
cione um desses pontos com o botão direito do mouse,
depois clique com o botão esquerdo dentro do círculo
branco (sem tocar no ponto azul, que é o eixo Z) e
arraste para ver como a forma da curva pode ser de-
terminada. Ao atingir uma forma parecida com a da
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figura 9.10, clique com o botão esquer-
do do mouse para fixar a posição do
vértice. Saia do modo de edição e vá para
o modo objeto (Tab).

Agora selecione o polvo e a linha e crie
uma relação de parenting entre os dois,
utilizando a opção de seguir o caminho
indicado pela linha (Ctrl+P, Follow Path)
(Figura 9.11).

A partir desse momento a animação do polvo seguindo o movimento da linha já está
determinada e pode ser visualizada clicando-se Alt+A. Outra maneira de se conferir o
movimento passo a passo é utilizar os botões do cursor no teclado. Os botões de movi-
mentação para a esquerda e para a direita trocam os quadros da animação um a um. Já
os botões de movimentação para cima e para baixo trocam os quadros de dez em dez.
Grave o arquivo com o nome Polvo2.blend (File, Save).

Fig. 9.10:
Modificando a
forma de um
path.

Fig. 9.11:
Fazendo o
polvo seguir o
path.



Ca
de

rn
os

 de
 In

for
m

áti
ca

77

COMPUTAÇÃO GRÁFICA
Secretaria de Estado de Educação MG

MÓDULO 10:
ANIMAÇÃO PARA TV. RENDERIZAÇÃO DA ANIMAÇÃO. FORMATOS DE SAÍDA. CODECS.

10.1 ANIMAÇÃO PARA TV

Se o usuário quiser gerar uma animação para ser vista em uma televisão ou gerar o seu
próprio DVD, algumas dicas devem ser levadas em consideração. A primeira e mais
importante delas está relacionada com as linhas brancas pontilhadas que podem ser
visualizadas na vista da câmera. Se a animação for feita para ser vista em um computador,
a cena inteira será renderizada, inclusive algumas partes da cena que se encontram fora
dos limites das linhas pontilhadas citadas acima. Se a animação for mostrada em uma
televisão, haverá um corte de partes da cena devido a propriedades físicas do tubo de
raios catódicos da TV. A única parte da cena que temos certeza que será reproduzida é
aquela compreendida no interior do retângulo mais interno das linhas pontilhadas. As
partes da cena compreendidas entre o retângulo maior e o menor feito de linhas
pontilhadas podem ou não ser reproduzidas, dependendo do modelo do aparelho de
TV que estiver sendo usado. As que estiverem fora dos limites das linhas pontilhadas
não aparecerão de forma alguma nas telas de TV. O retângulo preto maior indica o
limite da janela de renderização. Na figura 10.1 indicamos a linha do retângulo mais
interno como um limite relativo e a linha do retângulo exterior como um limite absoluto
para animações para TV.

O segundo aspecto importante a ser levado em consideração é que o tamanho escolhido
para a imagem renderizada irá depender do padrão de TV escohido. O Blender oferece
as seguintes opções de formatos de saída para a imagem:

• PAL: 720 x 576 pixels – razão de aspecto 54:51
• NTSC: 720 x 480 pixels - razão de aspecto 10:11
• Default: O mesmo que PAL, mas com opções de TV
• Preview: 640 x 512 pixels. A imagem é reduzida em 50% e produz-se uma ima-

gem de 320 x 256 pixels.
• PC: 640 x 480 - razão de aspecto 1:1
• PAL 16:9: 720 x 576 pixels - razão de aspecto 64:45, para renderizações de TV

de formato largo.
• PANO: Renderiza uma imagem panorâmica da cena. 576 x 176 pixels - razão de

aspecto 115:100.

• FULL: 1280 x 1024 pixels - razão de aspecto 1:1

Fig. 10.1:
Limites de
visualização
na TV
indicados
pela vista da
câmera.
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O termo razão de aspecto tem relação com o fato de que os aparelhos de TV não tem
pixels quadrados, como os monitores de computador. Eles são retangulares, o que tor-
na necessário gerar imagens pré-distorcidas, que parecerão incorretas na tela do com-
putador, mas que aparecerão com as proporções perfeitas na tela da TV.

10.2. RENDERIZAÇÃO DA ANIMAÇÃO.

O processo de renderização consiste na execução de uma série de cálculos para a deter-
minação de cada ponto da imagem da cena, levando-se em consideração todos os da-
dos de construção, iluminação, cores, texturas, sombras, transparências e efeitos, para
se conseguir uma imagem bidimensional do ângulo de visão desejado. Isto é feito para
cada quadro da animação e é um processo intensivo de grande custo computacional.
Para renderizações de animações mais longas é comum deixarmos o computador funci-
onando 24 horas por dia, por vários dias. Renderizar produções profissionais de longa
duração pode ocupar centenas de computadores trabalhando em paralelo por vários
meses. Antes de efetuar a renderização final da animação, é comum se fazer pequenos
testes de trechos da animação em resolução menor, para conferência de detalhes da

composição da cena e dos movimentos dos
objetos e da câmera.

Vamos renderizar a animação do arquivo
Polvo.blend. Abra primeiro o arquivo (File,
Open). Agora selecione e movimente a câmera,
como aprendeu nos módulos anteriores, de
modo a obter uma visão de câmera parecida
com a da figura 10.2.

Agora escolha o formato de animação Preview, e depois clique no botão Anim, para
iniciar a renderização da animação (Figura 10.3). Espere a renderização terminar e de-
pois veja a animação clicando o botão Play.

10.3 ANTIALIASING

Quando um computador gera uma imagem, ele utiliza pontos para construí-la, chama-
dos de pixels. O programa tenta renderizar a cena atribuindo um valor de cor para cada
pixel da tela, dependendo das características da superfície de um objeto naquele pon-

Fig. 10.2:
Arquivo
Polvo.blend.

Fig. 10.3:
Controles de
formatos de
saída de
animação.



Ca
de

rn
os

 de
 In

for
m

áti
ca

79

COMPUTAÇÃO GRÁFICA
Secretaria de Estado de Educação MG

to. Essa abordagem não dá bons resultados quando há transições bruscas de cor, como
acontece entre bordas bem definidas. Problemas também acontecem quando há linhas
finas oblíquas, pois elas apresentam um quadriculado em “escada”.

A técnica utilizada para evitar esse tipo de problema, batizado de Aliasing, é chamada
de Anti-aliasing. Para fazer isso o programa faz o que é chamado de oversampling
(OSA), ou superamostragem de um pixel, tirando uma média dos valores numéricos dos
pixels que o circundam. Isto faz com que as bordas dos objetos se apresentem mais
suavizadas, assim como as linhas finas inclinadas. Dois exemplos podem ser vistos na
figura 10.4. O primeiro foi renderizado com o OSA desligado, e o segundo com o OSA
com o valor de oito. Note como o efeito de “escada” é significativamente melhorado.

O recurso de Anti-aliasing é um grande aliado para se melhorar a qualidade das imagens
computacionais, mas devemos levar em consideração que o seu uso aumenta bastante a
carga de cálculo necessária para a renderização. Diferentes valores de OSA devem ser
testados para se verificar o nível de qualidade aceitável para o usuário.

OSA desligado (off). OSA 8.

Os controles de Antialiasing podem ser acessados na aba
Render do botão Scene, no cabeçalho da janela 3D. Para
ativar o efeito é preciso acionar o botão OSA (Figura
10.5). Os botões numéricos logo abaixo selecionam o
valor do oversampling, variando de 5 a 16. Valores mai-
ores dão resultados mais suaves, mas o tempo de
renderização também é maior.

Repita a animação anterior mudando os valores de OSA. Você consegue ver alguma
diferença no resultado final?

10.4 FORMATOS DE SAÍDA.

Ao construirmos uma cena no Blender normalmente o fazemos com a intenção de
renderizá-la, ou como uma imagem fixa, ou como uma animação. Em cada um dos casos
existem opções de tipos de arquivos gráficos, fixos ou animados, para a gravação do
arquivo. Estes tipos de arquivos possuem extensões diferentes, pois são codificados de
modos específicos, cada um oferecendo suas próprias vantagens e desvantagens. Al-
guns formatos não são reconhecidos por alguns programas. O formato de saída deve
ser escolhido de acordo com o programa que queremos usar para ver ou montar a
animação final. Os arquivos gráficos de saída que o Blender nos oferece como opção são
apresentados a seguir.

Fig. 10.5:
Acesso ao
botão OSA.

Fig. 10.4
Renderização
com
Oversampling
(OSA).
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FORMATOS DE ARQUIVOS DE IMAGEM FIXA:

Ftype – Este formato usa um tipo de arquivo definido como Ftype, indicando que este
arquivo serve como um exemplo para o tipo de formato gráfico em que o Blender deve
gravar as imagens. Este método nos permite processar os formatos chamados de colour
map, ou mapa de cores.  Os dados do mapa de cores são lidos do arquivo e utilizados
para a conversão dos gráficos disponíveis em 24 ou 32 bits. Se a opção RGBA for esco-
lhida, é utilizado o número zero para representar a cor transparente. O Blender lê e
escreve formatos de mapa de cores (Amiga) IFF, Targa, (SGI) Iris e CDinteractive (CDi)
RLE.

Íris + Zbuffer – Formato padrão da empresa Silicon Graphics (SGI) com adição de
informações sobre Zbuffer.

Iris – Formato padrão da empresa Silicon Graphics (SGI)

HamX – Formato de arquivo 8 bits RLE (Run Length Encoded bitmap). Cria arquivos
exremamente compactos que podem ser mostrados rapidamente. Para ser usado com a
opção Play.

Jpeg – Formato que utiliza compressão de dados com pequenas perdas na qualidade da
imagem. Se a alta qualidade da imagem for um fator de importância é melhor não usá-
lo.

Bmp – Antigo formato de arquivo bitmap.

PNG – Portable Network Graphics. Padrão desenvolvido para substituir o antigo forma-
to GIF. Formato sem perdas que permite o uso de imagens com mais cores do que o GIF
original.

Targa Raw – Formato Targa sem compressão. Ocupa muito espaço em disco, mas oferece
o máximo de fidelidade.

Targa – Formato Targa com compressão. Arquivos menores, sem perda de informação.

FORMATOS DE ARQUIVOS DE ANIMAÇÃO:

QuickTime – Formato de animação lido pelo programa Quick Time, da Apple.

AVI CODEC – Grava um arquivo de animação AVI, com compressão de dados determina-
da por um CODEC.

AVI Jpeg – Grava um arquivo de animação AVI como uma série de imagens Jpeg. Gera
arquivos pequenos, mas não muito, com perdas. Este formato não é lido por alguns
programas.

AVI Raw – Grava um arquivo de animação AVI sem compressão de dados, gerando
arquivos volumosos, mas sem perdas.

Para animações no formato AVI também é possível determinar a taxa de quadros por
segundo, que é definida por padrão em 25 fps.
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10.5 CODECS

Arquivos de vídeo e áudio ocupam muito espaço, por serem processos que se desenvol-
vem no tempo. Para que esses arquivos passassem a ter um tamanho menor e mais fácil
de ser manuseado, foi necessário desenvolver uma maneira de comprimi-los sem que
houvesse perdas significativas de qualidade. Existe uma classe especial de programas
de computador que utiliza algoritmos de compressão de dados, retirando a redundân-
cia contida nos arquivos e diminuindo muito o seu tamanho. Esses programas codifi-
cam e decodificam os dados, sendo por isso chamados de CODECs (COdificador-
DECodificador).

Para descomprimir um arquivo de vídeo e transformá-lo em imagens, é necessário utili-
zar o mesmo código que foi usado para a sua compressão. Isto se deve ao fato de que
cada programa tem uma maneira própria de efetuar a compressão de dados, tentando
privilegiar algum aspecto específico, tal como qualidade ou tamanho do arquivo. Sendo
assim, cada CODEC possui o seu algoritmo próprio de compressão e de descompressão,
devendo ser utilizado de acordo com as necessidades do usuário.

O Blender para Linux possui apenas o CODEC para o formato MJPG. Se o usuário quiser
comprimir o arquivo de vídeo em outro formato, deve primeiro renderizar as imagens
em um formato não comprimido e depois utilizar um programa externo para efetuar a
compressão. Ou então renderizar a animação em uma sucessão de imagens fixas e depois
utilizar um programa de edição de vídeo para montar o arquivo de vídeo final. Um bom
programa gratuito para efetuar esta edição é o Kino, para Linux.
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11.0 HOTKEYS

Edição básica

O mouse

• Botão Esquerdo: para acionar botões, controles deslizantes, entrada de texto e
posicionamento do cursor 3D

• Ctrl+Botão Esquerdo: adiciona um vértice

• Alt+Botão Esquerdo: substitui o botão do meio do mouse

• Botão do Meio: rotaciona o ponto de vista

• Shift+Botão do Meio: movimenta panoramicamente o ponto de vista

• Ctrl+Botão do Meio: controle de zoom

• Botão Direito: seleciona e ativa

• Shift+Botão Direito: extende a seleção

• Ctrl+Botão Direito: seleciona e ativa, somente nos centros dos objetos

• Rolete: Zoom positivo para a frente, zoom negativo para trás

O teclado

• F1: carrega arquivo

• F2: grava arquivo

• F3: grava imagem

• F12: renderiza imagem

• ESC: restaura ou escapa de qualquer opção

• Teclado numérico: ver abaixo

• Espaço: menu da caixa de ferramentas (toolbox)

• Teclado numérico - Vistas

• 5: alterna entre vista ortográfica ou vista em perspectiva

• 3: vista de lado

• 1: vista de frente

• 7: vista de topo

• 0: vista da câmera

• /: alterna entre vista local ou vista global

• Teclado numérico – Navegação

• 4: Orbita a vista para a esquerda

• 6: Orbita a vista para a direita

• 8: Orbita a vista para cima

• 9: Orbita a vista para baixo
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• Ctrl + 4: Panorâmica para a esquerda

• Ctrl + 6: Panorâmica para a direita

• Ctrl + 8: Panorâmica para cima

• Ctrl + 9: Panorâmica para baixo

• +: Zoom de aproximação

• -: Zoom de afastamento

• Enter: neutraliza o efeito zoom

Alinhamento de vistas

• C: centraliza a vista no cursor

• Shift + C: centraliza e visualiza tudo

• Ctrl + Alt + 0: alinha a câmera ativa à vista

• *: alinha a vista ao objeto selecionado

Seleção

Há três métodos básicos:

• Selecionar com o botão direito do mouse, extender a seleção com Shift

• Seleção por janela: tecle B e desenhe uma janela com o botão esquerdo do mouse

• Tecle A para selecionar ou deselecionar tudo

Ativar e selecionar

• Somente uma coisa pode estar ativa: o último objeto selecionado.

• Qualquer número de coisas pode ser selecionado, mas o objeto ativo aparece mais claro

Mover/rotacionar/escalar

• Translação: Tecle G para agarrar o objeto selecionado, mova o mouse e confirme a
posição clicando o botão esquerdo do mouse. Cancele a opção com ESC. Ou clique e
arraste com o botão direito do mouse. Pode-se usar o botão do meio do mouse para
restringir o movimento aos eixos X, Y ou Z.

• Rotação: Clique R para o modo de rotação. Confirme ou cancele como descrito acima.

• Escala: Clique S para o modo de escala. Mesmas opções de confirmação/cancelamento/
restrição X, Y, Z.

Objetos e Modo de Edição

A tecla TAB liga ou desliga o Modo de Edição (Editmode). No Modo de Edição, podemos
adicionar vértices e faces, proceder à extrusão de polígonos, assinalar cores ou desenhar
curvas. Entretanto não podemos adicionar ou ativar outros objetos. Para isso é necessário
deixar o Modo de Edição, clicando a tecla TAB. Se algo for adicionado estando-se no
Modo de Edição, ele é adicionado ao mesmo objeto.
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12.0 GLOSSÁRIO

Alpha –Alpha –Alpha –Alpha –Alpha – Em uma imagem digital, o valor de Alpha indica a sua opacidade. Zero é trans-
parente, Um é opaco.

Animação –Animação –Animação –Animação –Animação – Seqüência de imagens em sucessão rápida que dão a ilusão de movimento.
Em computação gráfica, é a modificação de qualquer característica ou posição de um
objeto, luz, material ou câmera ao longo do tempo.

Anti-aliasingAnti-aliasingAnti-aliasingAnti-aliasingAnti-aliasing –  –  –  –  – Método de suavização de bordas com transições bruscas. Utiliza a mé-
dia das cores dos pixels em torno do pixel analisado.

Ativo –Ativo –Ativo –Ativo –Ativo – O Blender faz uma diferença entre objeto selecionado e objeto ativo. Somente
um objeto pode estar ativo de cada vez. O objeto selecionado por último é considerado
o objeto ativo, e mostra seus dados nos botões correspondentes.

AVI –AVI –AVI –AVI –AVI – “Audio Vídeo Interleaved”. Um formato de arquivo para vídeo com áudio sincro-
nizado.

Bézier Bézier Bézier Bézier Bézier ––––– Tipo de curva onde os pontos de controle possuem um par de pontos de ajuste
que permitem a modificação da curva naquele ponto.

BitmapBitmapBitmapBitmapBitmap – – – – – Imagem digital codificada como uma série de pontos, ou pixels. Alguns exem-
plos de formatos de arquivos digitais bitmap são TIF, JPEG, Targa e Gif.

Câmera –Câmera –Câmera –Câmera –Câmera – Na computação gráfica é um objeto especial que é usado para simular a visão
da cena de um determinado ângulo, exatamente como seria visto através de uma câmera
real.

CMYK – CMYK – CMYK – CMYK – CMYK – Ciano, Magenta, Amarelo e Preto. Conjunto das cores utilizadas em impressão
gráfica.

CODEC – CODEC – CODEC – CODEC – CODEC – Compressor/Descompressor. Qualquer um de diferentes métodos para se
comprimir arquivos digitais de vídeo e tocá-los novamente.

Cor ambiente –Cor ambiente –Cor ambiente –Cor ambiente –Cor ambiente – A cor que um objeto reflete se não estiver sendo diretamente iluminado
por uma fonte de luz.

Digitalização – Digitalização – Digitalização – Digitalização – Digitalização – Processo de transformar imagens, objetos ou sons em uma forma digital
capaz de ser manipulada pelo computador.

EditModeEditModeEditModeEditModeEditMode – – – – – Modo de edição. Este modo permite a movimentação, escala, rotação, cria-
ção e apagamento de vértices de um objeto ativo.

Eixo – Eixo – Eixo – Eixo – Eixo – Uma linha imaginária no espaço 3D que define uma direção. Os eixos padrão
utilizados por programas 3D são X (horizontal), Y (vertical) e Z (perpendicular ao
monitor).

Escala – Escala – Escala – Escala – Escala – Transformação que ajusta o tamanho de um objeto.

Extrusão –Extrusão –Extrusão –Extrusão –Extrusão – Processo de se deslocar uma imagem bidimensional através do espaço,
criando um objeto 3D em seu caminho.
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Face – Face – Face – Face – Face – Área delimitada pelas arestas de um polígono, formando uma superfície de três
ou quatro lados.

Formato de arquivo –Formato de arquivo –Formato de arquivo –Formato de arquivo –Formato de arquivo – A maneira como os dados estão organizados em um arquivo de
computador. Exemplos de formatos de arquivos 3D: .blend, .3DS, .DXF e .OBJ.

Fps –Fps –Fps –Fps –Fps – “Frames per second”. Quadros por segundo. Indicação do número de quadros por
segundo visualizado em uma animação.

Grade –Grade –Grade –Grade –Grade – Linhas entrecruzadas vistas na janela 3D, utilizadas para se determinar
comparativamente a escala dos objetos criados.

IPO –IPO –IPO –IPO –IPO – O principal sistema de curvas de animação. Os blocos IPO podem ser utilizados
para se movimentar objetos e também para animar cores dos materiais.

Keyframe Keyframe Keyframe Keyframe Keyframe ––––– Ponto definido pelo usuário onde os eventos de uma animação acontecem.
Depois o programa interpola as ações entre os keyframes para fazer a animação.

Layer Layer Layer Layer Layer ––––– Pode ser considerado como uma marca de visibilidade. Possibilita trabalhar
com grupos de objetos, simultaneamente visíveis.

Malha Malha Malha Malha Malha (Mesh)(Mesh)(Mesh)(Mesh)(Mesh) –  –  –  –  – Termo utilizado em computação 3D para designar objetos criados com
uma malha de vértices que podem ser individualmente movimentados.

Material –Material –Material –Material –Material – Características assinaladas à superfície de um objeto virtual.

Modelagem –Modelagem –Modelagem –Modelagem –Modelagem – Projeto e construção de objetos tridimensionais virtuais no computador.

Normal –Normal –Normal –Normal –Normal – Linha imaginária que é perpendicular à face de um objeto, e que indica qual
lado do polígono é visível e para que direção ele está dirigido.

NTSC – NTSC – NTSC – NTSC – NTSC – Padrão de TV adotado nos Estados Unidos, com 29,97 quadros por segundo.

NURBS –NURBS –NURBS –NURBS –NURBS – Non Uniform Rational B-Splines. Tipo de curva que possui pontos de controle
em uma moldura que circunda a curva. Curvas fechadas podem formar superfícies, que
também podem ser controladas pelos pontos de controle.

Objeto –Objeto –Objeto –Objeto –Objeto – Termo que se refere a uma malha, superfície ou curva individual em uma cena,
que possui um nome próprio.

ObjectModeObjectModeObjectModeObjectModeObjectMode – – – – – Modo Objeto. Este modo permite a movimentação, escala, rotação, cria-
ção e apagamento de objetos.

Ortográfica –Ortográfica –Ortográfica –Ortográfica –Ortográfica – Projeção plana e bidimensional, sem distorções projetivas.

PAL – PAL – PAL – PAL – PAL – Padrão de vídeo europeu.

Parenting Parenting Parenting Parenting Parenting ––––– Método de agrupamento hierárquico de objetos.

Perspectiva –Perspectiva –Perspectiva –Perspectiva –Perspectiva – Maneira de representar a geometria onde as linhas que se afastam con-
vergem em pontos de fuga.

PivotPivotPivotPivotPivot – – – – – Ponto definido pelo usuário para ser o centro rotacional de um objeto. Geral-
mente é o mesmo onde os eixos locais do objeto se cruzam.

PixelPixelPixelPixelPixel – – – – – Unidade gráfica de uma imagem digital. O menor ponto representável.
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Polígono – Polígono – Polígono – Polígono – Polígono – Forma bidimensional fechada com três ou mais lados.

Ponto de origem –Ponto de origem –Ponto de origem –Ponto de origem –Ponto de origem – Ponto central do universo 3D computacional onde os eixos X, Y e Z
se encontram. Ele é identificado pelas coordenadas 0, 0, 0.

Primitiva –Primitiva –Primitiva –Primitiva –Primitiva – Qualquer forma geométrica tridimensional básica, tal como cubo, esfera,
cilindro, cone, etc.

Quadro Quadro Quadro Quadro Quadro (Frame) (Frame) (Frame) (Frame) (Frame) ––––– Em animação, é uma imagem fixa que faz parte de uma seqüência.

Razão de aspecto –Razão de aspecto –Razão de aspecto –Razão de aspecto –Razão de aspecto – A relação entre a largura e a altura de uma imagem, expressada em
uma razão decimal. Basta dividir a largura pela altura de uma imagem de, por exemplo,
10 x 7,5cm para se ter uma razão de aspecto de 1,3333.

Renderização –Renderização –Renderização –Renderização –Renderização – Processo onde o computador interpreta todos os dados da cena
construída e cria uma imagem finalizada da vista selecionada. A imagem resultante
pode ser fixa e única ou ser um quadro de uma animação.

RGB – RGB – RGB – RGB – RGB – Vermelho (Red), Verde (Green) e Azul (Blue). Conjunto das cores primárias de
luz. Modelo utilizado em monitores de computador e televisores para se conseguir criar
toda a gama de cores visíveis.

Seleção –Seleção –Seleção –Seleção –Seleção – O Blender faz uma distinção entre objeto selecionado e objeto ativo. Qualquer
número de objetos pode ser selecionado a qualquer momento, e praticamente todos os
comandos são aplicáveis aos objetos selecionados. Seleciona-se um objeto clicando
nele com o botão direito do mouse.

SmoothingSmoothingSmoothingSmoothingSmoothing – – – – – Processo de renderização que interpola as cores entre vértices e faces,
suavizando a superfície do objeto sem aumentar a complexidade da sua malha
tridimensional.

UV Mapping -UV Mapping -UV Mapping -UV Mapping -UV Mapping -  Processo utilizado para aplicar e posicionar uma imagem digital sobre a
superfície de um objeto 3D virtual.

Vértice –Vértice –Vértice –Vértice –Vértice – Nome genérico para um ponto bi ou tridimensional. É localizado pelas
coordenadas X, Y e Z.

X, Y e Z –X, Y e Z –X, Y e Z –X, Y e Z –X, Y e Z – Os três eixos do sistema de coordenadas tridimensional do mundo. X é um
eixo no sentido horizontal, Y no sentido vertical e Z está perpendicular à tela do
computador.

Wireframe Wireframe Wireframe Wireframe Wireframe ––––– Método de visualização que mostra os objetos 3D como se fossem construídos
de uma malha de arame.



Ca
de

rn
os

 de
 In

for
m

áti
ca

87

COMPUTAÇÃO GRÁFICA
Secretaria de Estado de Educação MG

13.0 RECURSOS NA WEB

EM PORTUGUÊS:

http://www.blender.com.br/portugues/index.php - http://www.blender.com.br/portugues/index.php - http://www.blender.com.br/portugues/index.php - http://www.blender.com.br/portugues/index.php - http://www.blender.com.br/portugues/index.php - Portal em português dedicado
ao Blender. Artigos, tutoriais, Chat e muito mais.

http://natanael.procedural.com.br/manual/book1.html - http://natanael.procedural.com.br/manual/book1.html - http://natanael.procedural.com.br/manual/book1.html - http://natanael.procedural.com.br/manual/book1.html - http://natanael.procedural.com.br/manual/book1.html - Manual do Blender sendo
traduzido em português. Uma grande parte já está pronta.

http://www.procedural.com.br/modules/news/ -http://www.procedural.com.br/modules/news/ -http://www.procedural.com.br/modules/news/ -http://www.procedural.com.br/modules/news/ -http://www.procedural.com.br/modules/news/ - Site para usuários mais experientes.

http://www.3dzine.com.br/ -http://www.3dzine.com.br/ -http://www.3dzine.com.br/ -http://www.3dzine.com.br/ -http://www.3dzine.com.br/ - Site sobre programas 3D em geral, inclusive o Blender.

EM INGLÊS:

http://blender.org/cms/Home.2.0.html -http://blender.org/cms/Home.2.0.html -http://blender.org/cms/Home.2.0.html -http://blender.org/cms/Home.2.0.html -http://blender.org/cms/Home.2.0.html - Site oficial do Blender.

http://www.blender3d.org/documentation/htmlI/ -http://www.blender3d.org/documentation/htmlI/ -http://www.blender3d.org/documentation/htmlI/ -http://www.blender3d.org/documentation/htmlI/ -http://www.blender3d.org/documentation/htmlI/ - Manual oficial do Blender.

http://blender3d.com/cms/Blender.31.0.html -http://blender3d.com/cms/Blender.31.0.html -http://blender3d.com/cms/Blender.31.0.html -http://blender3d.com/cms/Blender.31.0.html -http://blender3d.com/cms/Blender.31.0.html - Blender em diversas versões para
download.

http://blender3d.com/cms/Resources.181.0.html - http://blender3d.com/cms/Resources.181.0.html - http://blender3d.com/cms/Resources.181.0.html - http://blender3d.com/cms/Resources.181.0.html - http://blender3d.com/cms/Resources.181.0.html - Vários recursos para usuários do
Blender. Tutoriais, artigos, etc.

http://www.elysiun.com/forum/ - http://www.elysiun.com/forum/ - http://www.elysiun.com/forum/ - http://www.elysiun.com/forum/ - http://www.elysiun.com/forum/ - Fórum de discussões sobre o Blender. Bom lugar
para se resolver dúvidas específicas.




